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PREFACIO 
 
 

El número 4 de la serie de Cuadernos de Geomática es en realidad una guía práctica. Ante la 
necesidad que en ocasiones tenemos de conocer la dinámica de la escorrentía en cuencas de drenaje, 
sobre todo en su forma de caudal, se han ido desarrollando una serie de enfoques, cada vez más 
sofisticados, de análisis basados en el uso de modelos hidrológicos. 

Sin embargo, en el proceso histórico de su desarrollo, los modelos se han ido haciendo cada vez 
más complejos, de manera que hoy en día no sólo es necesario tener un cierto conocimiento del significado 
y alcance de uso que pueden tener los modelos hidrológicos de manera general e independientemente de 
su tipo y características, sino que también son instrumentos relativamente complejos que requieren un cierto 
conocimiento y aprendizaje como herramientas que pueden ayudarnos a resolver algunas cuestiones 
relacionadas con la gestión hídrica de las cuencas y experimentar ante situaciones de previsión y 
planteamiento de escenarios posibles, aunque no necesariamente reales. 

La presente guía pretende cubrir ambas necesidades. Se ha dividido en dos secciones. En la 
primera se abordan los principales conceptos relacionados con la modelización hidrológica superficial. En 
ella se tiene en cuenta las características, tipologías, definiciones y estructuras de los modelos, 
distinguiéndose entre modelos de flujo (los que tratan únicamente el caudal) y de transporte (los que 
además del caudal analizan algún tipo de material arrastrado y/o contenido en el agua). En esta primera 
parte también se describen de manera sucinta algunos de los modelos más conocidos sean de flujo (MIKE-

SHE, HEC-HMS, TETIS) como de transporte (SWAP, AnnAGNPS, WEPP). 
La segunda parte se dedica, única y exclusivamente, al uso del programa HEC-HMS 
(HydrologicEngineering Center), desarrollado en el US Army Corp of Engineers. Diseñado a modo de tutorial 
de autoaprendizaje, se detallan profusamente todos los pasos que se deben seguir desde la configuración 
del modelo hasta la consecución final de resultados, pasando por todo el tratamiento que se debe dar a los 
datos iniciales para que pueden ser representados adecuadamente por la aplicación. Para aquellos que 
quieran seguir el procedimiento de modelización planteado en esta segunda parte, se ha incluido también la 
información digital de partida requerida por el modelo HEC-HMS. 
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1. Introducción 

Los modelos hidrológicos son herramientas 

muy útiles para la comprensión del 

funcionamiento de una cuenca de drenaje, 

siendo una consecuencia lógica en el intento por 

conocer los procesos de conversión de la 

precipitación en escorrentía y, también, de la 

capacidad del agua para transportar sustancias. 

Los modelos de última generación se definen 

por ser “integradores”, entendiendo esto como 

un enfoque del modelado con el que se pretende 

incorporar información diversa y con el mayor 

detalle de representación del medio que se 

modela. Si bien desde hace ya bastantes décadas 

se han ido desarrollando un continuo de 

procedimientos para la estimación de la 

escorrentía basados en el concepto del 

Hidrograma Unitario que pueden considerarse 

como formas incipientes de modelizar de 

manera sintética los procesos de transformación  

de la precipitación en escorrentía dentro de una 

cuenca, los modelos que aquí se tratan son 

formas  más complejas que tienen en cuenta la 

diversidad de los procesos  que concurren para 

producir caudal. Este tipo de modelos han sido 

desarrollados más recientemente, a partir de los 

años 70 del Siglo XX; son también de naturaleza 

distribuida, con representación espacial de los 

procesos que ocurren en la cuenca. 

En consecuencia, esta primera parte dedicada 

a la “modelización hidrológica” se centra 

exclusivamente en los modelos de escorrentía 

superficial y se ha dividido en tres secciones: 

La primera de ellas contextualiza el modelado 

hidrológico prestando atención sobre todo a una 

serie de conceptos (incluida la definición de 

modelo (s) hidrológico (s), su tipología, 

desarrollo y forma de uso), que ayuden a 

familiarizarnos con sus propiedades y 

características. 

La segunda sección se dedica exclusivamente 

a los modelos de flujo (o de escorrentía 

superficial). En ella se explican, en primer lugar, 

sus principales características y los tipos 

generales de modelos. A continuación se trata de 

las aplicaciones más comunes que se realizan con 

ellos. El último apartado describe algunos de los 

modelos más comunes y accesibles. 

La tercera sección sigue una estructura similar 

a la sección anterior pero, en este caso, se dedica 

a los modelos hidrológicos de transporte, 

haciéndose hincapié en sus principales 

características y tipología, aplicaciones y 

descripción de modelos. 

 

2. Definiciones y características de los 

modelos hidrológicos 

Desde sus inicios los modelos desempeñan 

un papel importante en muchas áreas de la 

hidrología. Por ejemplo, su aplicación es común 

en la previsión de la alarma temprana de riesgos 

de avenidas e inundaciones, la gestión y 

planificación de cuencas, en la agricultura, en el 

diseño de infraestructuras como pantanos y 

presas, los estudios de impacto del cambio 

climático, etc. 

Sin embargo, más allá de la aplicación directa 

de los modelos ya consolidados y fiables, son 

también instrumentos propios de la 

investigación y la ampliación del conocimiento, 

pues ayudan a la formalización de la 

comprensión científica de un sistema hidrológico 

por medio del planteamiento de escenarios, el 

análisis de las interrelaciones entre sus 

componentes y la proyección de situaciones 

hipotéticas de cambios, presentes y futuros. 

Debido a que los modelos llevan más de un 

siglo de desarrollo y ampliación de sus 

aplicaciones y postulados, éstos han ido creando 

un cuerpo propio de términos y conceptos que 

es necesario familiarizarse con ellos; por lo tanto, 

este apartado se dedica a su explicación desde 

tres aspectos: 

 

 La definición de modelo hidrológico y 

términos asociados con el proceso de 

modelado. 

 La tipología y características de los 

modelos. 

 La estructura de construcción y 

procedimiento a seguir en su aplicación. 

 

2.1. ¿Qué es un modelo hidrológico? 
Se puede definir modelo como una 

representación simplificada del mundo real, que 

permite tener una idea de lo que ocurre bajo 

ciertas circunstancias. Los modelos hidrológicos 

intentan representar los diferentes procesos que 

se dan dentro de un espacio (generalmente una 

cuenca) y que transforman, en principio, una 

precipitación en escorrentía. 
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Si sustituimos mundo real por sistema 

complejo, entonces un modelo es una 

representación simplificada de un sistema 

complejo. Un modelo siempre describe los 

componentes básicos y más importantes de un 

sistema complejo, por lo tanto, un modelo trata 

de representar cierta semejanza y algunas, pero 

no todas, características del sistema real que 

simula. 

Desde un punto funcional, una cuenca de 

drenaje puede ser considerada como un sistema 

hidrológico. En esta conceptualización, las 

condiciones de límite del sistema están dibujadas 

alrededor de la cuenca: estos límites se 

establecen al considerar la cuenca como un 

elemento aislado de manera que sus divisorias se 

extienden verticalmente, hacia arriba y hacia 

abajo, mediante la proyección de la divisoria de 

aguas entre cuencas, y por medio de planos 

horizontales en sus límites superior e inferior 

(figura 1). 

De esa manera, la precipitación incidente es 

la entrada al sistema, y queda definida como la 

distribuida en el plano superior del espacio de la 

cuenca; el caudal es la salida, y es el resultante de 

la interacción de los distintos planos dentro de 

los límites de la cuenca: el flujo que se concentró 

en el espacio del sistema hidrológico y se 

cuantifica a la salida de la cuenca. La 

evaporación y el flujo subsuperficial también son 

salidas, pero si no intervienen como 

componentes que contribuyen al caudal 

modelado, se consideran pérdidas que escapan 

de los límites de la cuenca. 

 

 
 

 
Figura 1. La cuenca de drenaje como sistema hidrológico. 

Fuente: Chow et al. (1994, p 8) 
 

Al utilizar el concepto de sistema, el esfuerzo 

de simplificación del mundo real está dirigido a 

la construcción de un modelo de relación de 

entradas y salidas en lugar de a la más compleja 

(por imposible) tarea de la representación exacta 

de los datos del sistema, que puede no ser 

significativo desde el punto de vista práctico. No 

hay que olvidar que el objetivo de un modelo y 

del análisis del sistema hidrológico es estudiar y 

comprender su funcionamiento de manera que 

se pueda predecir su salida: un modelo del 

sistema hidrológico es una aproximación del 

actual sistema; sus entradas y salidas son 

variables hidrológicas medibles y su estructura se 

basa es el concepto de simplificación del sistema. 

En su visión más esquemática, la 

representación de la cuenca como sistema a 

modelar y la estimación de la escorrentía 

producida en ella en su flujo de salida 

(hidrograma), puede relacionarse como un 

proceso agrupado en tres fases: precipitación 

(entradas), procesos intermedios producidos en 

el sistema hidrológico y producción de caudal 

(salidas) (figura 2). 



Guía práctica sobre la modelización hidrológica y el modelo HEC-HMS. Parte 1 / 3 

Serie: Cuadernos de Geomática (Nº 4) 

 

 

 
Figura 2. Representación esquemática de los 
procesosproducidos en una cuenca de drenaje. 

 
Los paulatinos avances del modelado 

hidrológico se han centrado en la ampliación de 

esa simplificación, sobre todo en la comprensión 

de los procesos intermedios y su relación entre 

las entradas y las salidas al sistema. Ello ha hecho 

que, y sobre todo a partir del momento de la 

incorporación de las nuevas tecnologías 

informáticas al proceso de modelado, se haya ido 

creando un vocabulario propio, con sus 

términos y conceptos, el cual es conveniente 

conocer:  

 Variable: se entiende como una 

característica de un sistema que puede ser 

medida, que asume diferentes valores 

cuando se mide en diferentes momentos. 

Precipitación, escorrentía, evaporación, 

temperatura, infiltración, son algunos 

ejemplos de variables incorporadas a un 

modelo hidrológico. Se distinguen tres tipos 

de variables: 

 

 Variable de entrada: se refiere a la 

componente inicial del sistema sobre el 

que se construye un modelo. En el caso 

de un modelo hidrológico, la 

precipitación es la variable de entrada a 

considerar. 

 Variables de estado: corresponden a la 

cantidad de materia o energía 

almacenada en cada uno de los 

componentes (subsistemas) que forman 

parte del sistema; por ejemplo, niveles 

de humedad en el subsistema suelos de 

un modelo hidrológico. 

 Variables de salida: componente final 

considerada en el proceso de modelado, 

el caudal en un modelo hidrológico. 
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 Abstracciones: por abstracciones se 

entienden las paulatinas pérdidas (o 

almacenamientos) del flujo del agua desde 

que esta entra en la cuenca hasta que sale 

como caudal. Algunas de estas 

abstracciones se producen en los procesos 

de evaporación, almacenamiento en 

superficie, infiltración y percolación del 

agua a capas profundas. 

 Parámetros: Valores numéricos que se 

asignan a los distintos componentes del 

modelo hidrológico. Pueden estar resueltos 

por asignaciones numéricas directas como 

también por su derivación utilizando 

formulación matemática. 

 Flujos: indican el proceso de transmisión 

entre los distintos subsistemas hidrológicos 

que establece el modelo por medio de la 

cantidad de materia o energía que viaja de 

un componente a otro en un intervalo 

determinado de tiempo. Afectan por tanto a 

los niveles, llenando unos (flujos de 

entrada) y vaciando otros (flujos de salida). 

 Condiciones iniciales: valores iniciales de 

las variables a partir de los cuales se 

establece el proceso de modelado y los 

flujos entre subsistemas.  

 

2.2. Tipo y clasificación de los modelos 

Los modelos hidrológicos se pueden 

clasificar de múltiples maneras, teniendo en 

cuenta criterios como el enfoque matemático 

que realizan, el grado de representación espacial 

de sus componentes, etc. Si bien es cierto que en 

la mayoría de los casos los modelos se describen 

por la forma o detalle que tienen de representar 

la superficie de  la cuenca (agregados, 

semidistribuidos y distribuidos), el enfoque 

matemático (deterministas y estocásticos) y la 

forma de plantear los procesos hidrológicos que 

analiza (de base física o empírica), a 

continuación se describen las características que 

se pueden dar en los modelos de acuerdo con la 

clasificación y tipología interrelacionada (figura 

3) ofrecida por Singh (1988): 

 

 Modelos materiales. Un modelo material 

es la representación del sistema por otro 

sistema, que tiene características similares, 

pero es mucho más fácil para trabajar que 

con el real: 

 

 Porque se cambia de escala a un tamaño 

asequible por el modelador (una 

maqueta) y se instala y experimenta en 

laboratorio. 

 O porque se usa otro sistema físico con 

propiedades similares a las del prototipo 

(modelo análogo), y aunque no se 

parecen físicamente sí se establecen 

correspondencias entre ellos. 

 

 Modelos simbólicos. Es una expresión 

simbólica en términos lógicos de una 

situación idealizada, relativamente sencilla 

que comparte las propiedades estructurales 

del sistema original. Aunque podrían 

expresarse de manera no matemática (por 

ejemplo un diagrama esquemático con los 

flujos y componentes que intervienen en el 

ciclo del agua de una cuenca), los modelos 

de naturaleza matemática son los que 

presentan mayor interés y los que se han 

desarrollado a lo largo de la historia del 

modelado en hidrología. Un modelo 

matemático expresa el  comportamiento del 

sistema por medio de un conjunto de 

ecuaciones, que pueden ir acompañadas de 

declaraciones lógicas expresando las 

relaciones entre las variables y parámetros. 

 Modelos teóricos, conceptuales y 

empíricos. Según el planteamiento 

matemático del modelo se diferencia entre: 

 

 Modelos teóricos: modelos basados en 

las leyes de la física. Un modelo teórico 

tiene una estructura lógica similar al 

sistema del mundo real y puede ser útil 

en circunstancias cambiantes. 

 Los modelos empíricos. Se basan en 

cálculos matemáticos fruto de la 

experimentación. Por tanto, contienen 

parámetros que pueden tener poco 

significado físico directo y pueden 

estimarse sólo mediante mediciones 

simultáneas de entrada y salida. 

 Modelos conceptuales. Son modelos 

intermedios entre los modelos teóricos y 

los empíricos. 
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Figura 3. Clasificación de los modelos hidrológicos. 
Fuente: Adaptado de Singh (1988), referido en Xu (2002) 

 

 Modelos lineales y modelos no lineales. 

Un modelo se puede organizar en términos 

de ecuaciones y procesos lineales y 

procesos no lineales. Un ejemplo típico de 

un modelo lineal es el Hidrograma Unitario 

en el que la simplificación de los procesos 

se realiza por medio de una secuencia lineal 

entre las entradas, los procesos intermedios 

y las salidas. Por el contrario, cuando se 

intenta abordar la mayor complejidad de los 

procesos físico-hidrológicos se recurre a 

modelos no lineales. 

 Modelos variables en el tiempo y 

modelos temporalmente no variables. Se 

considera al modelo como no variable en el 

tiempo cuando su relación entre entradas y 

salidas no cambia con el tiempo. La forma 

de la salida depende solamente de la forma 

de la entrada y no en el momento en el cual 

se aplica la entrada. Los modelos que no 

presentan esta propiedad se consideran que 

son variables en el tiempo. La mayoría de 

los sistemas hidrológicos son sensibles a las 

variaciones temporales aunque, para 

simplificar, algunos modelos asuman 

condiciones de no variabilidad temporal. 

 Modelos agregados, semidistribuidos y 

distribuidos. Un modelo es agregado 

cuando, independientemente de los 

procesos que considere, los parametriza 

como valores únicos para el conjunto de la 

cuenca, sin tener en cuenta su diversidad 

espacial (figura 4 A). Se considera 

distribuido al modelo que intenta 

representar con el mayor detalle dichos 

procesos y parámetros (figura 4 C). El 

modelo semidistribuido es aquel que da una 

representación intermedia de la diversidad 

espacial, utilizando zonas de 

comportamiento teóricamente similar que 

se consideran como agregadas (figura 4 B). 

 Modelos estocásticos y determinísticos. 

Los determinísticos no consideran 

aleatoriedad: en la formulación matemática 

una entrada dada produce siempre una 

misma salida. Un modelo estocástico tiene 

salidas que son, por lo menos, parcialmente 

aleatorias y se usa cuando esta variación es 

grande. 

 MODELO HIDROLÓGICO 

SIMBÓLICO 

NO MATEMÁTICO MATEMÁTICO 

MATERIAL 

ANÁLOGO LABORATORIO 

EMPÍRICO CONCEPTUAL TEÓRICO 

LINEAL NO LINEAL 

AGREGADO DISTRIBUIDO SEMIDISTRIBUIDO 

DETERMINÍSTICO ESTOCÁSTICO 

VARIABLE 

EN EL TIEMPO 

NO VARIABLE 

EN EL TIEMPO 
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(A) (B) (C) 

   

Figura 4. Modelos de tipo agregado (A), semidistribuido (B) y distribuido (C) 
 

 
2.3. Modelos: desarrollo y procedimiento de 

aplicación 

Se distinguen dos formas de acercamiento a 

los procesos de modelado. Una de ellas consiste 

en los procedimientos a seguir si el objetivo es el 

desarrollo de un modelo hidrológico, o la 

intervención en la construcción de uno de sus 

componentes. La otra aproximación se refiere a 

la forma de trabajar cuando se usa un modelo 

existente. En ambos casos se debe seguir unos 

procedimientos (protocolos) que se detallan a 

continuación. 

 

2.3.1. Proceso de desarrollo de un modelo 

El desarrollo de un modelo lleva implícitas 

una serie de fases que, aunque secuenciales, no 

son totalmente independientes, pues deben ser 

comprobadas, y el modelo verificado hasta que 

finalmente se considere apto para las 

simulaciones para las que ha sido concebido 

(figura 5): 

 

 La primera etapa en su construcción es el 

modelo perceptual. La elaboración de 

un modelo perceptual se basa en la 

comprensión por parte de las personas 

que van a trabajar sobre la unidad 

hidrológica  a representar, de manera que 

puedan ponerse en común la experiencia 

del modelador y su interacción con el 

sistema hidrológico. El modelo 

perceptual constituye la base del 

desarrollo de un modelo (o esquema) 

conceptual subsiguiente. 

 Modelo conceptual. Una vez resuelta la 

manera de entender el funcionamiento de 

los distintos componentes del sistema  

por medio del modelo perceptual, el 

conceptual  constituye ya la base del 

desarrollo de un modelo hidrológico 

final. Por consiguiente, éste ya es una 

formalización como modelo a través del 

cual se decide, por medio de 

formulaciones matemáticas, la definición 

de los límites del sistema, sus entradas, 

las variables de  estado, las salidas, las 

conexiones y flujos de los componentes 

del sistema, etc. Este tipo de modelo (de 

diseño) no debe confundirse con el 

modelo conceptual matemático 

mencionado en el punto 2.2. 

 El modelo procedural. Una vez 

elaborado el modelo conceptual, la 

siguiente fase construye el modelo 

teniendo en cuenta dos principales 

acometidos: (1) su traducción matemática 

para que se formulen las entradas, 

procesos intermedios y salidas según el 



Guía práctica sobre la modelización hidrológica y el modelo HEC-HMS. Parte 1 / 7 

Serie: Cuadernos de Geomática (Nº 4) 

diseño preestablecido por el modelo 

conceptual y (2) su ensamblaje por medio 

de código de programación informático 

para que las ecuaciones puedan 

resolverse en un modelo de 

computadora. 

 Calibración del modelo. El proceso de 

calibración consiste en la mejora selectiva 

de los parámetros iniciales del modelo de 

manera que este aproxime con mayor 

verosimilitud (sea más realista) los 

resultados estimados de la simulación. 

Normalmente la comprobación de la 

bondad del ajuste del modelo se realiza 

por medio de la comparación entre las 

variables hidrológicas medidas y las 

obtenidas con el modelo. 

 Validación del modelo. La fase de 

validación consiste en la comprobación, 

una vez calibrado, por medio de 

simulaciones, de que el modelo funciona 

correctamente y conforme a los fines 

para los que ha sido desarrollado. 

Además de ser funcional, debe valorarse 

también que pueda ser utilizado sin 

dificultades tanto por la comprensión de 

su funcionamiento como por los 

requerimientos para su parametrización. 

 

 
Figura 5. Esquema de los pasos a seguir en el proceso de desarrollo de un modelo. 

Fuente: Beven (2012, p. 4) 

 
2.3.2. Su aplicación: protocolo de modelado 

El proceso de modelado está sujeto también 

al seguimiento de una serie de pasos que van 

desde la misma elección del modelo que se 

considera idóneo para abordar los análisis 

hidrológicos hasta la evaluación del mismo como 

herramienta útil y que permita sucesivas 

simulaciones de acuerdo a las valoraciones 

realizadas en los pasos intermediados existentes 

entre la selección inicial y evaluación final del 

modelo. Estas distintas fases constituyen un 
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protocolo de modelado, las cuales pueden 

resumirse como: 

 

 Identificación del modelo. Es un 

proceso por el cual, ante la necesidad de 

un análisis hidrológico dado, se identifica 

el modelo que se considera más 

apropiado. En esta primera fase se debe 

estudiar el funcionamiento del modelo y 

familiarizarse con su conceptualización y 

estructura (ver ANEXOS I y II). 

 Introducción de datos al modelo. 

Requiere, en primer lugar, de la 

identificación de los datos que se 

demanden y su recopilación para 

seguidamente introducirlos en el modelo 

de acuerdo a sus propias exigencias y 

formatos de incorporación, sea mediante 

una interfaz manual o por medio de un 

archivo con un formato específico. 

 Calibración. La calibración consiste en 

un proceso de ensayo error con el que se 

ajustan los valores de algunos parámetros 

para que el hidrograma resultante se 

asemeje al observado (una serie de datos 

observados de caudal) de la manera más 

fiel posible. De esta forma se puede 

determinar el conjunto de parámetros 

representados en el modelo que reflejan 

con mayor exactitud el comportamiento 

de la cuenca. 

 Validación. Por medio de la validación 

de la calibración previamente realizada se 

consigue certificar la confianza en el 

modelo. Consiste en realizar sucesivas 

simulaciones utilizando los parámetros 

establecidos en la calibración con datos 

reales (precipitación y caudal, por 

ejemplo) de períodos distintos a los 

utilizados en la calibración. Si el análisis 

entre los resultados estimados por el 

modelo y los reales son satisfactorios 

(similares a los obtenidos en la anterior 

calibración) éste se considera validado y 

listo para ser usado. 

 Uso generalizado del modelo. 

Finalmente el modelo puede ser utilizado 

en la cuenca de manera fiable, lo que 

permite su aplicación ante distintos 

escenarios de simulación como el 

pronóstico de caudales para distintos 

sucesos de precipitación y la evaluación 

de la incidencia del régimen hídrico de la 

cuenca ante posibles impactos por 

modificación de la cubierta vegetal o 

alteraciones en los suelos. 

 

3. Modelos de flujo (escorrentía) 

La aproximación a la descripción de las 

características de los modelos de flujo, los 

modelos hidrológicos más convencionales, se ha 

dividido en tres apartados con los que se cubre 

(1) los aspectos técnicos y de modelado, (2) la 

enumeración de ejemplos con trabajos realizados 

con modelos hidrológicos y (3) la descripción de 

algunos modelos extensamente divulgados. Los 

modelos a los que se hará referencia son los de 

naturaleza semidistribuida y distribuida, los de 

mayor potencial y desarrollo actual. 

 

3.1. Características de los modelos de flujo 

Las características de los modelos se 

analizan, en primer lugar, teniendo en cuenta la 

arquitectura o forma de estructurar el proceso de 

modelado, normalmente por componentes del 

ciclo hidrológico, y, en segundo, por los 

enfoques de modelado. 

 

3.1.1. Estructura 

La estructura que adquiere un modelo es 

independiente del detalle de representación, del 

número de parámetros y de la definición 

temporal que utilice el modelo hidrológico en 

cuestión. En la actualidad los de naturaleza 

distribuida y/o semidistribuida abordan el 

proceso de modelado construyendo una 

estructura modular. La conceptualización en 

componentes prácticamente obliga a que los 

modelos deban ser construidos utilizando esa 

arquitectura modular; es decir, dividiendo el 

modelo en distintos submodelos interconectados 

entre sí (figura 6). 
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(A) 

 

(B) 

 
Figura 6. Estructura modular de dos modelos distribuidos distintos: (A) Mike-She; (B): HBV-96. 

Fuentes: (A) Vázquez et al. (2004); (B):Solomatine and Wagener (2011, p. 437) 
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Los modelos más exigentes en su 

arquitectura, los que ofrecen un alto nivel de 

detalle y complejidad en sus componentes y 

módulos, imponen la obtención de un número 

considerable de parámetros, frente a los más 

sencillos que se limitan a calcular los principales 

parámetros. Sin embargo, la mayoría de ellos 

abordan el modelado siguiendo una división 

convencional de los procesos y flujos 

hidrológicos que ocurren en la cuenca. En 

primer lugar, resuelven la entrada de 

precipitación (sea con una componente de lluvia 

únicamente o incorporando también un modelo 

de nieve), el almacenamiento y pérdidas en la 

fase aérea del ciclo hidrológico. En segundo 

lugar atienden a los procesos de generación de 

escorrentía superficial y transmisión de flujos en 

la zona del suelo en los distintos planos que 

éstos pueden dirigirse (vertical, horizontal o 

permanecer estacionario en el suelo como 

almacenamiento); finalmente, consideran la 

dinámica de la circulación del agua en las capas 

más profundas. 

Todos los modelos necesitan la 

incorporación de la situación inicial de la cuenca, 

sobre todo cuando se modela un evento. Sin 

embargo, cuando estamos ante cuencas de 

drenaje en las que se dispone de escasas 

mediciones reales y, también, de pocas 

capacidades para obtenerlas, en ese caso puede 

ser más conveniente y realista el recurrir a 

modelos que, aún concibiendo el modelado de 

manera que separa en los principales 

componentes expuestos con anterioridad (fase 

aérea, dinámica de los flujos en los suelos y 

circulación del agua a capas profundas) los 

integra y facilita el trabajo. 

Ese es el caso de modelos como el HEC-

HMS, el cual ha ido evolucionando a partir de 

modelos históricos más simples. Una de su 

principales herramientas a la hora de integrar los 

distintos componentes es la derivación de los 

valores iniciales de la cuenca a partir del número 

de curva (CN: Curve Number) y la posterior 

obtención del almacenamiento máximo de la 

cuenca ante circunstancias de humedad 

antecedente dadas y la precipitación neta. 

El número de curva se obtiene por medio de 

la combinación de tres características intrínsecas 

de la cuenca como son los usos del suelo-

cubierta superficial, la topografía y las 

propiedades hídricas del suelo. El proceso de 

cálculo entre el número de curva y los valores 

que de él se pueden derivar se basa en una 

formulación empírica sencilla, habiéndose 

constituido en un componente de algunos 

modelos hidrológicos. 

 

3.1.2. Modelado 

Se da una gran diversidad de diseño de los 

modelos hidrológicos que relacionan únicamente 

la precipitación con la escorrentía, o que 

relacionan los flujos del agua desde que entran 

en la cuenca hasta que salen de ella como caudal. 

Entre los distintos enfoques aplicados del 

modelado hidrológico están: 

 

 Modelado de sucesos versus 

modelado de flujo continuo. Algunos 

modelos pueden desarrollarse como 

modelos continuos: estos se utilizan para 

simular el flujo y otras funciones de la 

cuenca (por ejemplo, almacenamiento) 

durante largos períodos de tiempo. Por el 

contrario, hay modelos (o módulos de 

modelos) diseñados para la simulación de 

sucesos, apropiados para precipitaciones 

de crecida (eventos de tormenta) o para 

cuencas con régimen fluvial no 

constante. Estos modelos se utilizan con 

frecuencia con fines de diseño (por 

ejemplo, el diseño de una alcantarilla que 

admita el paso de un suceso con periodo 

de recurrencia de 100 años). 

 Tamaño de la cuenca y dimensión 

temporal del proceso de modelado. 

Los procesos a modelar y su 

representación en el modelo son 

sensibles a las dimensiones de la cuenca. 

La respuesta hidrológica integral 

depende, en primer lugar, de las 

dimensiones de las células de 

precipitación y, en segundo de las 

dimensiones de la superficie sobre la que 

se dan los procesos intermedios como la 

dimensión de las masas forestales y los 

procesos de transmisión de flujos de 

estas a lo largo de la ladera y a través de 

la zona no saturada, de manera que, 

dentro de una cuenca de varios cientos 

de kilómetros cuadrados, puede 

producirse escorrentía en una pequeña 
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cuenca de cabecera pero no aparecer 

como caudal en la mayor. 

Algunos modelos se utilizan para 

predecir los totales mensuales de 

escorrentía, mientras que otros están 

diseñados para analizar las tormentas 

individuales. Al igual que con la escala 

espacial, la determinación del intervalo de 

tiempo que se considera en el modelado 

es de gran importancia, pues de él 

dependen los tiempos de recorrido y 

transmisión de flujos. Los modelos de 

suceso que analizan un aguacero en 

cuenca pequeña necesariamente deberán 

considerar un modelado de paso de 

tiempo de minutos, mientras que los de 

flujo continuo, y algunos dedicados a la 

evaluación de recursos, serán diarios o, 

incluso, con aproximaciones de balance 

hídrico mensual. 

 Modelos de flujo urbano. Frente a los 

modelos de cuenca, normalmente 

conceptualizadas con baja o nula 

presencia de construcciones y, por tanto, 

ante condiciones de dinámica de flujos en 

canales naturales, se han desarrollado 

algunos modelos que contemplan en 

mayor medida la hidráulica del sistema 

urbano de manera que puedan 

establecerse los flujos de entrada a través 

del sistema de drenaje propios de las 

ciudades, así como la evacuación de 

flujos y la posibilidad de inundaciones. 

 Conexión con otros sistemas. En la 

actualidad, algunos modelos hidrológicos 

se diseñan teniendo en cuenta la 

posibilidad de ser conectados (o 

asociados) a otros sistemas como su 

vinculación a modelos atmosféricos. En 

ese caso, los modelos hidrológicos 

ofrecen una escala donde coinciden con 

los modelos climático-atmosféricos. 

Algunos modelos desarrollan funciones 

que permiten la incorporación de 

información espacial utilizando Sistemas 

de Información Geográfica o la conexión 

a sistemas de apoyo a la toma de 

decisiones para gestión hídrica y alarma 

temprana ante potenciales riesgos de 

inundación. 

 

3.2. Aplicaciones de los modelos de flujo 

En las últimas décadas, el uso y la 

aplicabilidad de los modelos hidrológicos 

distribuidos (incluidos también los 

semidistribuidos) ha ido ampliándose 

considerablemente. En la práctica, la cantidad de 

aplicaciones en las que se recurre a los modelos 

es muy extensa, máxime cuando pueden 

integrarse con otras técnicas espaciales como la 

teledetección, otros modelos ambientales y 

sistemas de gestión territorial. Como ejemplos 

de aplicaciones se han escogido cuatro grandes 

áreas de manera que se pueda tener una idea 

general y amplia desde la perspectiva de la 

gestión de los recursos hídricos: 

 

 Desarrollo de modelos. En la 

actualidad, los modelos hidrológicos 

siguen desarrollándose tanto con la 

creación de nuevos como en la 

ampliación de los ya existentes. Ello lleva 

consigo, de acuerdo al esquema general 

de desarrollo de un modelo de la figura 5, 

el planteamiento de su construcción 

(Bertens et al., 2000), y también la 

valoración de sus componentes en las 

fases de calibración y validación (Weber 

et al., 2010) y en el análisis de sensibilidad 

de parámetros (Vázquez et al., 2004). 

 Aplicación en la evaluación de 

impactos ambientales. La amplitud de 

los trabajos que consideran la incidencia 

de los impactos en el régimen hídrico de 

cuenca producidos por modificaciones 

ambientales es grande. Destacan tres 

áreas de aplicación: (1) las consecuencias 

de los incendios forestales en la 

evaluación de los volúmenes de 

escorrentía producidos y en la 

representación del hidrograma de cuenca 

(Seibert et al. 2010); (2) el reflejo de la 

dinámica de las alteraciones de las 

cubiertas vegetales en la hidrología de 

cuenca (Wagesho, 2014), y (3) la 

inundabilidad de zonas urbanas por el 

riesgo y consiguiente daño que las 

avenidas pueden producir en personas y 

bienes (Pina et al., 2014). 

 Gestión de cuencas. Lógicamente, el 

desarrollo y puesta a punto de modelos 

hidrológicos para evaluar y hacer un 



12/ J.A. Pascual Aguilar, M. Díaz Martín 

Series: Notes on Geomatics (Nº 4) 

seguimiento de las cuencas hidrográficas 

es una de las áreas de aplicación 

fundamentales de los modelos 

hidrológicos, en general, y de los 

distribuidos, en particular. Los aspectos 

de su aplicación y uso son muy variados y 

va desde la puesta a punto de un modelo 

determinado para poder evaluar el 

régimen de cuenca (Re et al. 2008) hasta 

análisis específicos para la cuantificación 

de las aguas superficiales como recurso 

hidrológico (Kiptala et al. 2014). 

 Cambio climático. Una de las áreas de 

aplicación de muchos estudios 

ambientales es precisamente la relación 

con el cambio climático, con los posibles 

impactos y la adaptación a las 

condiciones futuras que significarán las 

modificaciones en los sistemas naturales 

impuestas por la continuidad de estos 

impactos. La aplicación de los modelos 

hidrológicos al estudio del impacto 

ambiental tiene también una fuerte 

implantación. Como ejemplos cabe 

destacar el estudio individualizado de la 

incidencia del cambio climático en la 

frecuencia de las inundaciones en  

cuencas de drenaje (Camici et al. 2014) y 

la combinación de las consecuencias del 

cambio climático con el impacto de las 

modificaciones de los usos del suelo en 

cuencas de gran tamaño (López-Moreno 

et al. 2011). 

 

3.3. Descripción de algunos modelos de flujo 

Existe una gran cantidad de modelos 

hidrológicos (ver la tabla del ANEXO I con la 

síntesis de modelos realizada por Kampf y 

Burges (2007). Los más extendidos y generalistas 

abordan una amplia gama de escenarios de 

simulación, pudiendo ir desde cuencas pequeñas 

y sucesos individualizados hasta grandes áreas de 

drenajes y flujo continuo; desde la estimación de 

la escorrentía superficial hasta la combinación de 

ésta con transporte de partículas y su 

interconexión con las aguas subterráneas. A 

medida que la investigación en modelos 

hidrológicos avanza, que los modelos más 

consolidados amplían sus funcionalidades y que 

la demanda de modelos (incluyendo los 

comerciales) más generalistas –que aporten 

mayores potenciales de modelado bien 

directamente en el modelo o bien por su 

conexión con nuevos módulos- la separación de 

funciones y la clasificación de los modelos en el 

tipo de flujo que modela y si son únicamente de 

flujo o de transporte se hace más compleja. Sin 

embargo, en este apartado y en el 

correspondiente relativo a los modelos 

hidrológicos de transporte se ha considerado 

conveniente separarlos de manera que se puedan 

comprender sus principales características y 

potenciales de uso. En ambos casos se tratará 

con modelos hidrológicos de cuenca de drenaje. 

Con respecto a la descripción de algunos 

modelos de flujo, se han seleccionado tres por su 

distinta naturaleza, accesibilidad al usuario 

general y por su estructura y complejidad de uso. 

Estos son los modelos MIKE-SHE, HEC-HMS 

y TETIS. 

 

3.3.1. MIKE SHE 

Desarrollador/Institución: El actual 

modelo está desarrollado por el instituto danés 

de hidráulica (Danish Hydraulic Institute -DHI).  

Página WEB del 

modelo:http://www.mikebydhi.com/products/

mike-she 

Tipo de modelo: Es un modelo de 

naturaleza física que incorpora una gran cantidad 

de parámetros. Realiza una representación 

espacial de tipo distribuido basada en una malla 

regular con estructura de datos ráster y tamaño 

de celda (pixel) cuadrada (figura 6A). 

El modelo, actualmente comercializado por 

el DHI, no es de libre acceso, por lo que hay que 

pagar una cantidad considerable por su licencia. 

Descripción: MIKE SHE es un modelo 

que ha evolucionado a partir de su antecesor el 

“System Hydrologique European” (SHE),  

inicialmente desarrollado como proyecto 

conjunto entre tres organizaciones de Francia, 

Reino Unido y Dinamarca. 

Simula los flujos del agua en la totalidad de 

la fase terrestre del ciclo hidrológico. A pesar de 

su complejidad, tiene una estructura de 

modelado flexible que incluye un amplio rango 

de métodos numéricos para cada proceso. Tanto 

los procesos hidrológicos que se simulan como 

los métodos numéricos que se utilizan pueden 

combinarse según los requerimientos de 

aplicación y la disponibilidad de datos. 

http://www.mikebydhi.com/products/mike-she
http://www.mikebydhi.com/products/mike-she
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Permite la incorporación directa de 

información producida en distintos formatos y 

plataformas de Sistemas de Información 

Geográfica. 

En la estructura del modelo se distinguen 

cinco componentes principales, cada uno de 

ellos se ajusta a un conjunto de procesos y 

parámetros del ciclo hidrológico: 

 

 Precipitación y evapotranspriación. 

Se consideran los elementos de mayores 

dimensiones en el ajuste del balance 

hídrico que realiza. El cálculo de la 

evapotranspiración actual está basado en 

el consumo de la vegetación, para lo que 

también se utilizan parámetros de 

interceptación, de suelos, de agua 

almacenada en superficie, de la zona de 

raíces y las transmisiones hídricas como 

agua supsuperficial. 

 Precipitación de nieve. El modulo 

permite trabajar con almacenamientos 

de nieve. Una vez establecido el 

almacenamiento y el tipo de nieve (seca 

o húmeda), el modelo posee una serie de 

algoritmos para convertirla en 

escorrentía superficial, los cuales 

incluyen correcciones de temperatura 

según la altitud, de radicación solar y de 

precipitación sobre nieve. 

 Escorrentía superficial. El cálculo de 

la escorrentía superficial se realiza por 

medio de una doble alternativa: (1) un 

método simple de estimación basado en 

criterios de seimidistribución de la 

escorrentía superficial y (2) un método 

de diferencias finitas para la estimación 

detallada de la precipitación y el 

escurrimiento. 

 Flujo concentrado. El caudal se simula 

por medio de cálculos hidrodinámicos 

que incluyen también operaciones sobre 

estructuras hidráulicas tales como 

compuertas, bombeos y presas. El 

módulo también posee un conjunto de 

algoritmos de circulación del flujo 

menos exigentes en información que 

son apropiados para su aplicación a 

grandes redes. 

 Zona no saturada. El módulo realiza 

los cálculos relacionados con el flujo 

vertical no saturado. Para ello incluye un 

modelo de capas de la zona de raíces 

con el que se estima  el balance hídrico 

en la zona no saturada. Para la 

infiltración en suelos secos utiliza el 

modelo de Green y Ampt. 

 

3.3.2. HEC-HMS 

Desarrollador/Institución: Centro de 

Ingeniería Hidrológica (Hydrologic Engineering 

Center-HEC) del  Cuerpo de Ingenieros del 

Ejército de Estados Unidos (U.S. Army Corps of 

Engineers-USACE). 

Página WEB del 

modelo:http://www.hec.usace.army.mil/softwa

re/hec-hms/ 

Tipo de modelo: Es un modelo conceptual 

(de base física y empírica), con representación 

espacial semidistribuida por medio de la división 

de la cuenca en unidades menores de 

subcuencas. 

La licencia del modelo es de dominio 

público (de libre acceso), por lo que su descarga, 

así como una cantidad considerable de 

información, incluyendo los manuales de usuario 

de las distintas versiones, se puede realizar 

directamente desde su página WEB. 

Descripción: El modelo HEC-HMS ha 

seguido una larga tradición en su desarrollo, pues 

es la evolución directa del conocido y 

ampliamente utilizado HEC-1. El programa está 

diseñado para simular los procesos de 

conversión de la precipitación en escorrentía en 

cuencas dendríticas, tanto en condiciones 

naturales como intervenidas. 

Las nuevas versiones HEC-HMS presentan 

mejoras con respecto al antiguo HEC-1, 

incluyendo una mayor operatividad en el proceso 

de modelado distribuido, la simulación continua 

(no sólo de suceso) y, la interfaz gráfica de 

usuario que facilita las labores de entrada de 

datos antes del inicio del proceso de modelado y 

la gestión de la información generada después 

del modelado. 

Se ha desarrollado una aplicación (HEC-

GeoHMS) que facilita la incorporación de 

información espacial al modelo HEC-HMS. 

HEC-GeoHMS es una utilidad desarrollada para 

el Sistema de Información Geográfica ArcGIS y 

http://www.hec.usace.army.mil/software/hec-hms/
http://www.hec.usace.army.mil/software/hec-hms/
http://www.hec.usace.army.mil/software/hec-hms/


14/ J.A. Pascual Aguilar, M. Díaz Martín 

Series: Notes on Geomatics (Nº 4) 

principalmente está pensado para el desarrollo 

de los submodelos de cuenca de HEC-HMS. 

El programa trabaja con cuatro módulos 

básicos que definen en su conjunto la entrada de 

datos  y la estructura de simulación de la cuenca: 

 Datos de entrada. El programa 

presenta un sistema de entrada de datos. 

Datos que serán posteriormente tratados 

de acuerdo a los distintos submódulos 

de modelado para los que se requieren. 

 Modelo de cuenca. El modelo de 

cuenca es utilizado para representar la 

parte física de la cuenca. El usuario 

desarrolla un modelo de cuenca 

agregando y conectando elementos 

hidrológicos. Los elementos 

hidrológicos usan modelos matemáticos 

para describir los procesos físicos en la 

cuenca. 

 Modelo de precipitación. Calcula la 

precipitación requerida en una 

subcuenca. Se puede utilizar 

información puntual de precipitación o 

distribuida espacialmente. El módulo 

puede modelar precipitación sólida y 

liquida y, también, evapotranspiración. 

El cálculo de la evapotranspiración sólo 

es requerido cuando se modelan 

respuestas hidrológicas en largos 

períodos de tiempo. 

 Módulo de control. Las 

especificaciones de control fijan el 

tiempo de duración de cada ejecución de 

una simulación. Las especificaciones de 

control deben incluir la fecha de inicio, 

la fecha de finalización y el intervalo de 

tiempo (minutos, horas, días) de la 

simulación. 

 

3.3.3. TETIS 

Desarrollador/Institución: Grupo de 

Investigación de Modelación Hidrológica y 

Ambiental (GIMHA) del Área de Investigación 

de Hidráulica e Hidrología del Instituto de 

Ingeniería del Agua y el Medio Ambiente 

(IIAMA), de la Universidad Politécnica de 

Valencia (España). 

Página WEB del modelo: 

http://lluvia.dihma.upv.es/ES/software/softwa

re.html 

Tipo de modelo: Es un modelo conceptual 

(de base física y empírica), con representación 

espacial distribuida basada en una estructura 

raster de malla regular cuadrada. 

La licencia del modelo es de dominio 

público. Su descarga se hace directamente desde 

la página WEB en la que está  alojado el modelo, 

previo la cumplimentación de un formulario de 

usuario. 

Descripción: TETIS es un modelo global, 

es decir, con un mismo modelo se pueden 

resolver problemas tanto de crecidas y erosión 

(discretización temporal de minutos y horas) 

como de Recursos Hídricos (discretización 

temporal diaria). Además, tiene un potente 

algoritmo de calibración automática de sus 

parámetros efectivos y de los valores iniciales de 

todas las variables de estado, que facilita su 

implementación práctica. Desarrollado 

inicialmente para cuencas de montaña, el modelo 

está ya adaptado para ser aplicado también a 

cuencas grandes con diversidad de usos del suelo 

y topografías contrastadas. 

El modelo se basa en una entrada de datos 

inicial que facilita su posterior ejecución y 

simulación de hidrogramas. Pero no posee 

ninguna facilidad para incorporar directamente 

datos espaciales creados con Sistemas de 

Información Geográfica, ni conexiones a ellos 

que facilite la entrada de información espacial. 

Sin embargo, estos documentos iniciales están 

construidos en formato ASCII (de texto) con 

una estructura similar a los formatos de 

exportación de ArcGIS, por lo que es posible 

producirlos en ese o cualquier otro Sistema de 

Información Geográfica y posteriormente 

adaptarlos a los requerimientos de TETIS. 

Para cada celda de la cuenca, el modelo 

efectúa un balance de agua siguiendo una 

conceptualización de tipo tanques (figura 7). La 

simulación de la producción de escorrentía para 

cada celda se basa en describir las interacciones 

atmósfera – vegetación – suelo – acuífero a 

través de cinco tanques interconectados entre sí. 

Los flujos de agua entre cada tanque representan 

los procesos más significativos en el ciclo 

hidrológico: precipitación (lluvia o nieve), 

evapotranspiración, infiltración, percolación y 

http://lluvia.dihma.upv.es/ES/software/software.html
http://lluvia.dihma.upv.es/ES/software/software.html


Guía práctica sobre la modelización hidrológica y el modelo HEC-HMS. Parte 1 / 15 

Serie: Cuadernos de Geomática (Nº 4) 

pérdidas subterráneas. Las salidas posibles de 

agua para cada celda se da por los tres 

componentes principales de la escorrentía: la 

escorrentía directa (producida por escorrentía 

hortoniana y escorrentía por saturación), el flujo 

subsuperfical y el flujo base. Cada proceso 

involucrado se simula con ecuaciones simples y 

con pocos parámetros para estimar. La 

formulación hidráulica utilizada en el modelo 

TETIS se basa en una aproximación de la onda 

cinemática, asumiendo un lecho fijo en cada 

celda en el cual se aplica una ecuación de 

balance. 

 

 

 
 

Figura7. Esquema conceptual de tanques a nivel de celda del modelo TETIS 

Fuente: Francés García et al. (2014) 
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4. Modelos de transporte 

En paralelo con el progreso de los modelos 

hidrológicos distribuidos y semidistribuidos se 

ha ido desarrollando también una serie de 

modelos hidrológicos cuyo objetivo es la 

estimación de las cargas de sustancias que 

pueden ser arrastradas por los flujos. A estos 

modelos se les da el nombre general de modelos 

de transporte, existiendo una gran variedad de 

ellos. Este apartado sobre modelos de transporte 

se centrará en los modelos hidrológicos de 

cuenca y exclusivamente en aquellos que, aunque 

también puedan simular el flujo, tienen la 

habilidad de estimar las concentraciones de otras 

sustancias como contaminantes de origen 

agrícola y sedimentos. Al igual que para los 

modelos de flujo, esta parte  se ha dividido en 

tres apartados en los que se exponen (1) los 

aspectos técnicos y de modelado, (2) el 

comentario de ejemplos con trabajos realizados 

con modelos hidrológicos de transporte y (3) la 

descripción de algunos de ellos. 

 

4.1. Características de los modelos de 
transporte 

Las características de los modelos de 

transporte se analizan en este apartado desde 

una doble perspectiva: (1) según su estructura 

para analizar el transporte de sustancias teniendo 

en cuenta el proceso de conversión de 

precipitación en escorrentía y (2) por los 

enfoques de modelado a los que dan lugar este 

tipo de aplicaciones. 

 

4.1.1. Estructura 

Los modelos de transporte que simulan a 

escala de cuenca de drenaje descansan en gran 

medida en la representación inicial de los 

procesos involucrados en la fase terrestre del 

ciclo hidrológico, teniendo en cuenta la 

conceptualización de los distintos componentes 

y flujos que intervienen en la conversión de la 

precipitación inicial en escorrentía concentrada 

en cauce. 

En consecuencia, la estructura de un modelo 

de transporte ha de tener al menos dos grandes 

módulos de simulación (figura 8). Uno de ellos 

se corresponde con la generación del 

hidrograma, sea de suceso o de flujo continuo, y 

el otro con el respectivo modelado del soluto 

y/o material transportado por el agua de acuerdo 

a su capacidad de arrastre ante las características 

específicas de la cuenca y las circunstancias 

individuales de la precipitación (si se trata de una 

simulación de evento) o del flujo permanente (si 

se trata de una simulación de flujo continuo). 

Inicialmente se resuelven los componentes 

en los que se ha conceptualizado el modelo; por 

ejemplo dinámica del agua en el suelo y en la 

zona no saturada, flujos de escorrentía 

superficial, flujo vertical del agua hacia capas 

profundas por debajo de la zona no saturada, 

escorrentías subsuperficiales entendidas como 

flujos laterales, aportes de flujo base, etc., de 

manera que se simula un hidrograma de salida 

con unas características determinadas debido a 

las distintas fases y tipos de aportes que 

contribuyen a su forma. 

  Asociados a los procesos anteriores se 

determinan las tasas de transporte de los 

materiales modelados; en la figura 8 se muestran 

dos tipos muy distintos de materiales como son 

sedimentos procedentes del arrastre de partículas 

del suelo de distinto tamaño y los 

contaminantes, entendidos estos en gran medida 

como de origen difuso y agrícola. 

 Los módulos de simulación de los 

materiales transportados por el agua 

necesariamente han de ser distintos dependiendo 

del tipo de carga que se simula pues, al menos, 

debe distinguirse entre  material arrastrado por la 

fuerza del flujo en la fase del ciclo hidrológico 

que se simula (transporte de sedimentos) y 

contaminante disuelto en el agua con un 

potencial de biodegradación (transporte de 

contaminantes). Es por ello que los modelos de 

transporte que atienden a más de un tipo de 

sustancias (ver figura 8) se estructuran de manera 

que sean módulos de simulación separados. 

En el proceso de simulación, los modelos 

requieren de  la incorporación de datos reales, 

observados. En primer lugar, para la valoración 

de los hidrogramas simulados con respecto a los 

verdaderos y, en segundo, y de manera idéntica a 

la comparación del hidrograma medido con el 

simulado, para el cotejo de las simulaciones de 

materiales transportados con respecto a los 

valores reales medidos. 
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Figura 8. Ejemplo de estructura de modelado de un modelo hidrológico de transporte (Modelo SHETRAN). 

Fuente: Ewen et al. (2000) 

 
4.1.2. Modelado 

Los modelos de transporte se sustentan en 

una doble estructura que combina las 

características de los modelos hidrológicos de 

flujo y las propias del traslado de las materias 

transportadas. Con respecto al modelado de 

flujo, los modelos de transporte adoptan las 

distintas estrategias de modelado comentadas en 

el punto 3.1.2.: modelado de sucesos y de flujo 

continuo, estructuración del modelo teniendo en 

cuenta el tamaño de la cuenca y la dimensión 

temporal del proceso de modelado, desarrollos 

para el modelado del ciclo del agua en zonas 

urbanas y la adaptación y conexión con otros 

sistemas de modelado. 

Si se atiende a los procesos referidos al 

transporte de sustancias que realizan los modelos 

hidrológicos de transporte, en ese caso hay que 

distinguir entre los varios tipos de carga que se 

modela, pudiéndose diferenciar entre dos 

grandes grupos: (1) el transporte y arrastre de 

sedimentos o materiales procedentes de la parte 

superficial del suelo y (2) el transporte de 

sustancias que van disueltas en el agua, por 

ejemplo los contaminantes: 

 

 Transporte de sedimentos. El 

modelado del transporte de sedimentos 

exige que se contemple una serie de 

circunstancias propias de los diferentes 

tamaños que pueden tener los 

sedimentos pues, dependiendo de su 

calibre, éstos serán más susceptibles a 

ser, en primer lugar, arrancados y, 

después, trasladados en suspensión o 

arrastrados por la fuerza de los flujos. 

Los algoritmos de los modelos tienen en 

cuenta el proceso inicial de arranque del 

material (comúnmente considerado 

como un proceso de erosión “in situ”) y 

los de transporte a lo largo de las laderas 

debido a flujos superficiales y también a 

flujos laterales subsuperficiales. 

Finalmente, los modelos estiman su 

acumulación y transporte en volumen de 

sedimentos por el flujo concentrado. 

 Transporte de sustancias disueltas 

en el agua. Consideradas las sustancias 

disueltas en el agua como potenciales 

contaminantes, los modelos se 

desarrollan bajo una conceptualización 
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de su procedencia, principalmente 

relacionada con la distribución espacial 

de los usos y cubiertas del suelo y las 

prácticas de manejo y gestión que llevan 

asociadas. La formulación tiene en 

cuenta, además, el tipo de material que 

se transporta (fertilizantes, pesticidas, 

etc.), de manera que se considera su 

propio ciclo de pervivencia, posible 

degradación y potencial trasformación. 

Una vez establecidos los orígenes y 

cargas del material a transportar, los 

modelos establecen los cálculos de su 

transporte a lo largo de la cuenca y su 

acumulación final en el flujo 

concentrado. 

 

4.2. Aplicaciones de los modelos de 
transporte 

Las características de las aplicaciones con 

modelos de transporte se exponen de acuerdo al 

desarrollo de modelos, la gestión de cuencas y 

los impactos que pueden ocurrir en una cuenca 

de drenaje, incluido el cambio climático: 

 

 Desarrollo de modelos. Al ser una de 

las áreas de la modelización hidrológica 

de más reciente desarrollo, la creación 

de modelos es relativamente frecuente. 

Sin embargo, en muchos casos se sigue 

la tradición de tomar modelos de cuenca 

ya existentes a los que se les modifica y 

amplía con nuevos módulos para que 

simulen el transporte. De esa manera, y 

aprovechando los modelos distribuidos 

(y semidistribuidos), se han desarrollado 

modelos generalistas de transporte de 

sedimentos y solutos (Ewen et al., 2000), 

y también modelos para circunstancias 

específicas de cultivo y contaminantes 

como el construido para simulación de 

pesticidas utilizados en el cultivo del 

arroz (Boulange et al., 2014). 

 Adaptación para el análisis y gestión 

de cuencas. La necesidad de conocer 

las tasas de erosión, la producción de 

sedimentos y la movilización de las 

cantidades de contaminantes a través de 

las cuencas de drenaje para una mejor 

gestión de los recursos y la 

cumplimentación de la legislación 

medioambiental hace que se recurra a la 

adaptación de modelos de transporte. El 

proceso de adaptación de un modelo 

para la evaluación y seguimiento del 

transporte de sustancias necesariamente 

requiere que éste se calibre y valide 

(Hahn et al., 2013). Una vez aceptado 

como un instrumento efectivo, el 

modelo puede ser utilizado en la gestión 

de cuencas de distintos tamaños, no sólo 

pequeñas como el ejemplo anterior 

(Hahn et al., 2013), sino mucho más 

grandes (Domínguez et al, 2006; Gaisera 

et al., 2008). 

 Impactos y cambios ambientales. La 

evaluación de los impactos y cambios 

ambientales son áreas de estudio y 

aplicación inherentes a la naturaleza de 

los modelos de transporte. Tres son las 

áreas más destacadas de su aplicación: 

(1) los incendios forestales por el 

potencial que presenta para aumentar las 

tasas de erosión y transporte de 

sedimentos y contaminantes (Rosso et 

al., 2007); (2) las alteraciones impuestas 

por los cambios de usos del suelo y la 

gestión de las cubiertas superficiales 

asociadas (Cai et al., 2011) y (3) las 

modificaciones impuestas por el cambio 

climático (Donner et al., 2002; Ma et al., 

2014). 

 

4.3. Descripción de algunos modelos de 
transporte 
De entre los distintos modelos de transporte 

que existen se describen a continuación tres (los 

modelos SWAT, AnnAGNPS y WEPP). Se 

utilizan como ejemplos de esa variedad, pues 

abordan de distinta manera el modelado de 

cuenca: SWAT es un modelo continuo a escala 

temporal diaria que simula un amplio espectro 

de materiales susceptibles de ser transportados; 

AnnANGPS modela también un buen número 

de sustancias que pueden ser transportadas pero 

es consecuencia de la integración de partes de 

otros modelos, y WEPP es un modelo para la 

estimación de la erosión en laderas y pequeñas 

cuencas agrícolas. Para más información sobre 

otros modelos se recomienda la lectura del 

trabajo de Borah y Bera (2003) que incluye la 
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revisión de once modelos de transporte, cuyas 

características se incluyen en el ANEXO II. 

 

4.3.1. SWAT 

Desarrollador/Institución: El modelo Soil 

and Water Assessment Tool (SWAT) ha sido 

desarrollado por el “Grassland, Soil and Water 

Research Laboratory” en Temple (Texas), 

perteneciente al Servicio de Investigación sobre 

Agricultura (Agricultural Research Service-ARS) 

del Departamento de Agricultura de los Estados 

Unidos (United States Depatment of 

Agriculture-USDA).  

Página WEB del modelo: 

http://swat.tamu.edu/. 

Tipo de modelo: Es un modelo conceptual 

de cuenca de naturaleza espacial semidistribuida, 

desarrollado para evaluar el impacto del manejo 

y prácticas realizadas en suelos en cuencas 

complejas (con diversidad de cubiertas 

superficiales) y grandes. 

La licencia del modelo es de dominio 

público (de libre acceso), por lo que se puede 

descargar directamente desde su página WEB. 

Descripción: El modelo es capaz de 

simular en cuencas agrícolas el transporte de 

sedimentos, nutrientes, pesticidas y bacterias, 

además de la escorrentía superficial.  SWAT 

divide la cuenca sobre la que realiza el modelado 

en subcuencas, creando dentro de ellas distintas 

Unidades de Respuesta Hidrológica de acuerdo a 

la información específica que se le provee sobre 

cubiertas superficiales/usos del suelo, suelos y 

topografía. Las simulaciones que realiza el 

modelo para cada Unidad de Respuesta 

Hidrológica son posteriormente integradas 

(generalizadas) en cada subcuenca. 

El módulo hidrológico de SWAT estima por 

separado la escorrentía que se produce en cada 

subcuenca. Para ello la escorrentía superficial se 

calcula por medio de un modelo de balance 

hídrico del suelo basado en datos diarios de 

precipitación. La escorrentía estimada en cada 

subcuenca es posteriormente conducida e 

integrada para calcular la escorrentía total que se 

produce en la cuenca. 

Con respecto al transporte de 

contaminantes, el modelo estima, en primer 

lugar, su acceso a los distintos tramos del sistema 

de drenaje, para después transportarlos hasta la 

salida de la cuenca o punto de salida sobre el 

cual se construye el espacio geográfico que se 

modela. 

Para el cálculo de la erosión, el modelo tiene 

implementado un módulo basado en la ecuación 

universal de pérdida del suelo modificada 

(Modified Universal Soil Loss Equation-

MUSLE), que considera distintos aspectos 

relevantes para la producción de erosión y 

sedimentos como la agresividad de la lluvia, el 

tipo de cultivo y sus prácticas de manejo y la 

susceptibilidad del suelo a ser erosionado. 

Permite la incorporación de información 

espacial por medio de una extensión (ArcSWAT) 

creada para el Sistema de Información 

Geográfica ArcGIS.  

 

4.3.2. AnnAGNPS 

Desarrollador/Institución: El modelo 

AnnAGNPS ha sido desarrollado por el servicio 

de conservación de los recursos naturales 

(Natural Resources Conservation Service-NRCS) 

del Departamento de Agricultura de los Estados 

Unidos (United States Depatment of 

Agriculture-USDA). 

Página WEB del modelo: 

http://www.nrcs.usda.gov/wps/portal/nrcs/det

ailfull//?cid=stelprdb1042468. 
Tipo de modelo: Es un modelo de base 

física, espacialmente distribuido, con la división 

de  la cuenca en malla de celdas regulares 

cuadradas. Modela el transporte de distintos 

materiales de manera continua a escala temporal 

diaria. 

La licencia del modelo es de dominio 

público (de libre acceso). Es fácilmente accesible 

desde su página WEB. 

Descripción: AnnAGNPS es una versión 

mejorada del modelo de suceso ya existente 

AGNPS (Agricultural Non-Point Source Model).  

El Nuevo AnnAGNPS guarda muchas de las 

características de modelado de su predecesor, 

pero incluye nuevos algoritmos para la 

estimación de flujos laterales subsuperficiales. El 

modelo divide la cuenca en pequeñas áreas de 

drenaje con valores ambientales homogéneos de 

usos del suelo, suelos, y otros factores que 

intervienen en el proceso hidrológico y de 

transporte de sustancias. Estas sub-áreas se 

integran para simular la escorrentía superficial y 

la carga de contaminantes a lo largo de la red de 

drenaje de manera que se pueda evaluar la 

contaminación difusa de la cuenca. 

http://swat.tamu.edu/
http://www.nrcs.usda.gov/wps/portal/nrcs/detailfull/?cid=stelprdb1042468
http://www.nrcs.usda.gov/wps/portal/nrcs/detailfull/?cid=stelprdb1042468
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Para la simulación de la erosión y otros 

procesos, AnnAGNPS incorpora componentes 

de varios modelos como el modelo RUSLE 

(Revised Universal Soil Loss Equation-RUSLE), 

el modelo CREAMS ( Chemicals, Runoff, and 

Erosion from Agricultural Management Systems, 

el modelo GLEAMS (Groundwater Loading 

Effects on Agricultural Management Systems) y 

el modelo EPIC (Erosion Productivity Impact 

Calculator). 

AnnAGNPS hace una división de la cuenca 

que se modela en subcuencas utilizando la 

integración de celdas que se consideran como 

pertenecientes a una misma Unidad de 

Respuesta Hidrológica. Calcula el contenido de 

humedad del suelo por medio del método del 

número de curva. 

Para facilitar la incorporación espacial se ha 

creado un programa (TOPAZ) que permite la 

comunicación de AnnAGNPS con Sistemas de 

Información Geográfica. 

 

4.3.3. WEPP 

Desarrollador/Institución: El modelo ha 

sido desarrollado por el Servicio de 

Investigaciones sobre Agricultura (Agriculture 

Research Service-ARS) del Departamento de 

Agricultura de los Estados Unidos (United States 

Department of Agriculture-USDA) 

Página WEB del modelo: 

http://www.ars.usda.gov/News/docs.htm?doci

d=10621. 
Tipo de modelo: WEPP (Water Erosion 

Prediction Project) es un modelo conceptual 

distribuido basado en procesos que se simulan 

tanto de manera continua como con sucesos. 

La licencia del modelo es de dominio 

público (de libre acceso), pudiéndose acceder al 

mismo desde su página WEB. 

Descripción: El modelo simula escorrentía 

superficial y producción de sedimentos en 

laderas y en pequeñas cuencas de drenaje. 

Permite la simulación de escenarios debidos a los 

efectos de los cultivos, su rotación y 

características del terreno cultivado. 

WEPP tiene una estructura modular entre 

cuyos componentes están los que tratan los 

datos meteorológicos (incluida la acumulación 

de nieve y su fusión),  la irrigación, los procesos 

de escorrentía superficial, el balance hídrico, el 

crecimiento de las plantas, la gestión de residuos, 

la alteración del suelo por labranza y los 

procesos de erosión. 

El modelo, para predecir la erosión 

considera los procesos erosivos  tanto de la 

escorrentía laminar como la concentrada en 

regueros. Incorpora componentes de otros 

existentes como una modificación del balance 

hídrico y percolación del modelo SWRRB 

(Simulator for Water Resources in Rural Basins) 

y de estimación de la erosión del modelo EPIC 

(Erosion Productivity Impact Calculator). 

Existe una extensión para ArcGIS 

(GeoWEPP) que facilita el trabajo con modelos 

digitales de elevación para la extracción de 

información topográfica y su incorporación 

como datos de entrada al modelo. 

 

5. Algunos comentarios finales 

Desde los primeros modelos desarrollados 

en la primera mitad del siglo XX, basados en 

formulaciones empíricas y de naturaleza 

agregada para toda la cuenca, los modelos 

hidrológicos han ido progresando en su 

desarrollo y ampliando sus aplicaciones. Sin 

embargo, hay que tener en cuenta que a lo largo 

de su historia los modelos han mantenido unas 

características definitorias que han permitido 

distinguir un tipo de otro. 

Se diferencian por su aproximación 

matemática (empírica, conceptual y física), por  

la formulación simplificada de los procesos de 

manera consecutiva (lineal) o por si se 

consideran inter-relaciones entre ellos que lo 

alejan de la linealidad secuencial, por si son fijos 

(no variables) o por si tienen en cuenta la 

variabilidad temporal del conjunto de procesos, 

por si consideran la cuenca como un ente 

unitario (modelos agregados) o tienen en cuenta 

la variabilidad espacial de los parámetros 

(semidistribuidos y distribuidos) y por el enfoque 

matemático fijo (determinístico) o tienen en 

cuenta la aleatoriedad o incertidumbre de los 

procesos y los resultados (estocástico). 

Tanto en el desarrollo de los modelos como 

en su aplicación deben seguirse una serie de 

pasos o fases. Si se trata de su construcción, la 

secuencia va desde la primera fase de 

determinación del modelo perceptual, seguida 

por el diseño de un modelo conceptual y la 

construcción del modelo procedural, hasta las 

últimas de calibración y validación, de manera 

http://www.ars.usda.gov/News/docs.htm?docid=10621
http://www.ars.usda.gov/News/docs.htm?docid=10621
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que éste se considere apropiado para su uso 

generalizado. En cuanto al uso de los modelos, 

se debe establecer un protocolo el cual consiste 

en la identificación del modelo más apropiado a 

las necesidades para las que se requiere, la 

introducción de datos,  y su calibración y 

validación en la cuenca en la que se va a aplicar 

de manera que permita su uso generalizado. 

Cada vez es más frecuente el que los 

modelos realicen otro tipo de simulaciones más 

allá de la mera conversión de la precipitación en 

flujo concentrado (caudal), por lo que cabe 

distinguir entre modelos de flujo exclusivamente 

y entre modelos que, además del flujo, estiman el 

transporte de sustancias, como sedimentos y 

contaminantes de origen agrícola. 

Los modelos de flujo de naturaleza 

distribuida se caracterizan por ser modelos 

complejos que abordan la simulación de los 

distintos componentes del ciclo hidrológico 

terrestre teniendo en cuenta la variedad de 

representación de los parámetros, flujos y filtros 

existentes en una cuenca de drenaje: son 

modelos espacialmente distribuidos (o 

semidistribuidos) con estructuras en varios 

módulos (precipitación-evapotranspiración, 

dinámica del agua en el suelo y zona no saturada, 

transmisión de flujos a capas profundas y 

lateralmente en la zona no saturada, etc.). Tienen 

una amplia variedad de aplicaciones que alcanzan 

desde la evaluación de los recursos hídricos de 

cuenca, hasta la valoración de impactos 

(incendios forestales, cambios de cubiertas 

superficiales) y análisis de escenarios de cambio 

climáticos. Ejemplos de dichos modelos son 

MIKE-SHE (bajo licencia comercial), HEC-

HMS y TETIS (bajo licencia abierta de dominio 

público).  

Los modelos de transporte a escala de 

cuenca se caracterizan por, además de incorporar 

una módulo de simulación de escorrentía, tener 

otros adicionales que evalúan y estiman cargas de 

materiales transportados por arrastre-suspensión 

o dilución. Algunos modelos de este tipo 

presentan algoritmos de varios tipos de 

contaminantes y transporte de sedimentos, 

mientras que otros se dedican a un solo tipo (por 

ejemplo, sedimentos). Tienen también un amplio 

uso y un número considerable de aplicaciones 

que van desde su calibración y validación como 

instrumentos de análisis y gestión de cuencas a 

distintas escalas, hasta su aplicación para la 

evaluación de la incidencia de impactos 

ambientales en  la calidad del agua y la 

simulación de escenarios de cambio climático. 

Ejemplos de modelos hidrológicos de transporte 

son los  modelos SWAT, AnnAGNPS y WEPP. 
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7. ANEXOS 
 

7.1. ANEXO I.  Características de 19 modelos hidrológicos de flujo 

Fuente: Kampf y Burges (2007) 
 

7.2. ANEXO II. Características de 11 modelos hidrológicos de transporte 

Fuente: Borah y Bera (2003) 
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7.1. ANEXO I: Características de 19 modelos hidrológicos de flujo (Kampf y Burges, 
2007) 
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7.2. ANEXO II. Características de 11 modelos hidrológicos de transporte (Borah y Bera, 

2003) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Guía práctica sobre la modelización hidrológica y el modelo HEC-HMS. Parte 1 / 29 

Serie: Cuadernos de Geomática (Nº 4) 

 
 
 
 



30/ J.A. Pascual Aguilar, M. Díaz Martín 

Series: Notes on Geomatics (Nº 4) 

 
 
 
 
 
 
 
 



Guía práctica sobre la modelización hidrológica y el modelo HEC-HMS. Parte 1 / 31 

Serie: Cuadernos de Geomática (Nº 4) 

 
 
 
 
 
 
 
 
 
 
 



32/ J.A. Pascual Aguilar, M. Díaz Martín 

Series: Notes on Geomatics (Nº 4) 

 



	
	
	
	
	
	
	
	
	
	
	
	
	

PARTE 2: La aplicación práctica del modelo HEC-HMS	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	



34/ J.A. Pascual Aguilar, M. Díaz Martín 

Series: Notes on Geomatics (Nº 4) 

1. Introducción 

Para el desarrollo del siguiente caso práctico se utilizarán las siguientes versiones de los 

programas: 

 ArcGIS 10.x. 

 HEC-HMS 4.1.  

 HEC-GeoHMS 10.x for ArcGIS 10.x. 

Tanto HEC-HMS como HEC-GeoHMS son software libre y pueden descargarse en las 

siguientes páginas web: 

 HEC-HMS: http://www.hec.usace.army.mil/software/hec-hms/downloads.aspx  

 HEC-GeoHMS: http://www.hec.usace.army.mil/software/hec-geohms/downloads.aspx 

 

2. Enunciado del ejercicio 

Calcular el hidrograma asociado al periodo de retorno de 10 años del río Alberche en régimen 

natural a su paso por el término municipal de Nombela (Toledo). 

 

3. Planteamiento del ejercicio 

Para resolver el problema vamos a crear un modelo hidrológico mediante HEC-HMS 

(HYDROLOGIC ENGINEERING CENTER, 2015) cuyo resultado final es un hidrograma que 

nos dará el caudal pico asociado al periodo de retorno T=10. Como se trata de un modelo en 

régimen natural, deben despreciarse los embalses existentes en la cuenca. 

Una de las principales entradas al modelo son los datos espaciales que caracterizan cada una de 

las subcuencas: superficie, longitud de cauce más largo, pendiente, etc. Estos datos se obtendrán 

a partir de un Modelo Digital del Terreno mediante HEC-GeoHMS (HYDROLOGIC 

ENGINEERING CENTER, 2013) y se importarán directamente a HEC-HMS. 

En los siguientes apartados se enunciarán las diferentes partes o submodelos que conforman 

el modelo HEC-HMS, los posibles métodos de cálculo de los parámetros hidrológicos (indicando 

cuál de ellos se va a utilizar), así como la información de partida que será necesaria para 

completar cada submodelo. 

Posteriormente se indica el tratamiento que hay que dar a los datos de partida para obtener los 

parámetros de entrada al modelo. 

Finalmente se explica cómo se introducen los parámetros en el modelo, cómo se realiza la 

calibración del modelo a partir de datos registrados y cómo se consultan los resultados tras la 

simulación. 

 

4. Descripción del modelo HEC-HMS 

A grandes rasgos, el modelo HEC-HMS se estructura en los siguientes submodelos: 
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4.1. Modelo de cuencas (Basin Model) 

Este modelo se divide en cuatro elementos: 

 Subcuencas (Subbasin): para definir cada subcuenca necesitamos los siguientes datos: 

 Description: pequeña descripción de la cuenca. No es imprescindible. 

 Latitude Degrees, Latitude Minutes, Latitude Seconds, Longitude Degrees, Longitude Minutes, Longitude 
Seconds: indica la localización de la cuenca. No es imprescindible. 

 Downstream: indica el elemento del modelo al que se conectará aguas abajo cada una de las 
subcuencas. Esta conexión quedará definida mediante el esquema de red hidrográfica que 
se genera con HEC-GeoHMS. 

 Area (KM2): superficie de la subcuenca en km2. Se obtiene mediante HEC-GeoHMS. 

 Canopy Method: representa la cantidad de agua de lluvia que queda interceptada por la 
cubierta vegetal y no llega al terreno. En el modelo despreciaremos este factor. 

 Surface Method: representa la cantidad de agua de lluvia que queda almacenada en 

depresiones del terreno. En el modelo despreciaremos este factor. 

 Loss Method: representa la cantidad de agua de lluvia que se infiltra en el terreno. En el 
modelo seleccionaremos el método SCS Curve Number. Los valores de Número de Curva de 
cada subcuenca se calculan según la metodología que posteriormente se explicará, 

utilizando ArcGIS. 

 Transform Method: representa la cantidad de lluvia neta que se transforma en escorrentía. En 
el modelo seleccionaremos el método SCS Unit Hydrograph. Este método se basa en el 

parámetro T-Lag (tiempo de retardo), que se calcula a partir del tiempo de concentración, 
que a su vez se calcula con los resultados obtenidos en HEC-GeoHMS. 

 Baseflow Method: representa la escorrentía que existe en el cauce antes de producirse la 
avenida. En el modelo seleccionaremos el método Recession. El principal dato de entrada es 

el caudal inicial (Initial Discharge), que se calculará mediante ArcGIS partiendo del Mapa de 
escorrentía total anual. 

 Tramos de cauce (Reach): para definir cada tramo necesitamos los siguientes datos: 

 Downstream: es el elemento del modelo al que se conectará aguas abajo cada tramo de cauce. 
Esta conexión quedará definida mediante el esquema de red hidrográfica que se calcula con 
HEC-GeoHMS. 

 Description: pequeña descripción del tramo. No es imprescindible. 

 Routing Method: representa cómo evoluciona el hidrograma entrante en la cabecera del tramo 
a medida que discurre a lo largo del cauce, experimentando fundamentalmente cierto 
retardo y atenuación. En el modelo seleccionaremos el método Muskingum-Cunge. Los datos 
de entrada se obtendrán a partir del Modelo Digital del Terreno, mediante ArcGIS. 

 Loss/Gain Method: representa las pérdidas o ganancias de caudal que pueden producirse a lo 
largo del tramo de cauce. En el modelo despreciaremos este factor. 

 Confluencias (Junction): para definir cada confluencia necesitamos los siguientes datos: 

 Description: pequeña descripción de la confluencia. No es imprescindible. 
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 Downstream: es el elemento del modelo al que se conectará aguas abajo cada confluencia. 

Esta conexión quedará definida mediante el esquema de red hidrográfica que se calcula con 
HEC-GeoHMS. 

 Salida (Sink): para definir la salida necesitamos los siguientes datos: 

 Description: pequeña descripción del punto de salida. No es imprescindible. 
El programa HEC-HMS permite introducir otros elementos como embalses (Reservoir), 

fuentes (Source) o derivaciones (Diversion), que no utilizaremos en este ejercicio práctico. 
 

4.2. Modelo Meteorológico (Meteorologic Model) 
Para definir el modelo necesitamos los siguientes datos: 

 Description: pequeña descripción del modelo. No es imprescindible. 

 Shortwave: representa la radiación solar de onda corta. En el modelo despreciaremos este 
factor. 

 Longwave: representa la radiación solar de onda larga. En el modelo despreciaremos este 
factor. 

 Precipitation: representa la precipitación en forma de lluvia. En el modelo seleccionaremos el 
método Specified Hyetograph. El dato de entrada es el hietograma, que se obtendrá a partir de 
los datos facilitados por la AEMET. 

 Evapotranspiration: representa la cantidad de agua que se pierde mediante 

evapotranspiración. En el modelo despreciaremos este factor. 

 Snowmelt: representa el aporte de agua en forma de nieve. En el modelo despreciaremos este 
factor. 

 Unit System: seleccionamos Metric. 

 Replace Missing: representa la manera de gestionar la falta de datos meteorológicos. En el 

modelo seleccionaremos Abort Compute, que cancela el cálculo en caso de falta de datos. 

 Basin: en esta pestaña se selecciona el modelo de cuenca asociado al modelo meteorológico. 

 Option: en esta pestaña se selecciona si se quieren ajustar los datos de precipitación de cada 
medida. En el modelo seleccionamos No. 

 

4.3. Especificaciones de Control (Control Specifications) 
Para definir el modelo necesitamos los siguientes datos: 

 Description: pequeña descripción. No es imprescindible. 

 Start Date, Start Time, End Date, End Time: indican la hora y el día que comienza la 
simulación. 

 Time Interval: seleccionamos 1 Hour. 
 

5. Datos de partida 

A continuación se indican los datos de partida necesarios para el desarrollo del ejercicio, así 
como los lugares de donde se pueden obtener para así poder realizar estudios en otras zonas de la 
geografía española. Estos datos se adjuntan en formato digital en el siguiente enlace: 
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https://drive.google.com/file/d/0B62MEhCydHW3UFlka3MzM2dFZnM/view?usp=sh

aring 

	
5.1. Modelo Digital del Terreno 
Descripción: Modelo Digital del Terreno de la cuenca con paso de malla de 25 m. Archivos con 
formato ASCII matriz ESRI (asc). 

Fuente: Centro de Descargas del Centro Nacional de Información Geográfica (CNIG, 2009). 
Enlace: 
http://centrodedescargas.cnig.es/CentroDescargas/buscadorCatalogo.do?codFamilia=02107 

Nombre del archivo: son 24 archivos con la siguiente denominación: MDT25-XXXX-H30, 
siendo XXXX el número de hoja en el MTN50. 

 
5.2. Mapa de cauces 
Descripción: Red hidrográfica principal de la parte española de la Demarcación Hidrográfica del 
Tajo. 
Fuente: Confederación Hidrográfica del Tajo (2016). 

Enlace: http://www.chtajo.es/Servicios/Paginas/DescargaDCapas.aspx 
Nombre del archivo: Red_hidro_ppal_v.shp 
Observaciones: este mapa no es imprescindible, ya que los principales cauces de la cuenca se 

obtendrán de HEC-GeoHMS, pero puede ser de gran utilidad para la definición de las 
subcuencas. 
 

5.3. Mapa de usos del suelo del CORINE 
Descripción: Mapa de ocupación del suelo en España, correspondiente al proyecto europeo 
Corine Land Cover. 

Fuente: Agencia Europea de Medio Ambiente (2006). 
Enlace: 
http://centrodedescargas.cnig.es/CentroDescargas/buscadorCatalogo.do?codFamilia=02113 
Nombre del archivo: CLC06_es.shp. 

 

5.4. Mapa de grupos hidrológicos 
Descripción: Mapa de grupos hidrológicos de España. 

Fuente: Norma 5.2 - IC Drenaje Superficial de la Instrucción de Carreteras (BOE, 2016a). 
Enlace: https://www.boe.es/boe/dias/2016/03/10/pdfs/BOE-A-2016-2405.pdf 
Nombre del archivo: BOE-A-2016-2405 (figura 2.7). 

 

5.5. Localización de estaciones meteorológicas 
Descripción: Mapa de localización de estaciones meteorológicas. 

Fuente: Sistema de Información Geográfica de Datos Agrarios (SIGA) (MAPAMA, 2016a). 
Nombre del archivo: Estaciones_ETRS89.shp 
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Observaciones: El archivo incluye exclusivamente las estaciones de la zona de estudio, en el 

sistema ETRS89. Como se verá más adelante, este archivo no es necesario para resolver el 
ejercicio. 
 

5.6. Hietogramas de diseño 
Descripción: Hietogramas de diseño de cada subcuenca. 
Fuente: los hietogramas se han elaborado partiendo de los datos de precipitación máxima diaria 

mensual facilitados por la Agencia Estatal de Meteorología (AEMET, 2016), tal y como se 
explicará más adelante. 
Nombre del archivo: Hietogramas.xlsx 

Observaciones: Según Resolución de 30 de diciembre de 2015, de la Agencia Estatal de 
Meteorología, por la que se establecen los precios públicos que han de regir la prestación de 
servicios meteorológicos y climatológicos, publicada en el BOE núm. 4 de 5 de enero de 2016 
(BOE, 2016b), los datos de precipitación máxima diaria mensual son gratuitos. 

 

5.7. Escorrentía total anual 
Descripción: Mapa de escorrentía total anual. Archivo ráster. 

Fuente: Sistema Integrado de Modelización Precipitación Aportación (SIMPA) (MAPAMA, 
2016b).  
Enlace: http://www.mapama.gob.es/es/cartografia-y-sig/ide/descargas/agua/simpa.aspx 

Nombre del archivo: aes4005. 
 

5.8. Correspondencia de usos del suelo entre CORINE y SCS 
Descripción: Tabla Excel con la correspondencia entre los usos del suelo definidos por el mapa 
CORINE y por el SCS. 
Fuente: Aportación de la teledetección para la determinación del parámetro hidrológico del 

número de curva (Ferrer et al., 1998). 
Nombre del archivo: Correspondencia_usos_suelo.xlsx 

 
5.9. Asignación de valores de Número de Curva 
Descripción: Tabla Excel con la correspondencia entre los códigos del método de los números 
primos y el número de curva. 
Fuente: Generación automática del número de curva con sistemas de información geográfica 

(Ferrer et al., 1995). 
Nombre del archivo: Número_curva.xlsx 

 

5.10. Secciones transversales del cauce 

Descripción: Secciones transversales característica de cada tramo del cauce principal. 

Fuente: se elaboran a partir del Modelo Digital del Terreno mediante ArcGIS. 

Nombre del archivo: Muskingum-Cunge.xlsx. 
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Observaciones: estas secciones son necesarias para calcular el tránsito del hidrograma a lo largo 

del cauce principal del río Alberche. 

 

5.11. Tormenta registrada 

Descripción: Datos de precipitaciones y caudales registrados en la estación AR22 Cofio en San 

Martín entre los días 20 y 24 de abril de 2011. 

Fuente: Sistema Automática de Información Hidrológica (SAIH) (MAPAMA, 2016c).  

Enlace: http://sig.mapama.es/saih/ 

Nombre del archivo: Datos_calibración.xlsx 

Observaciones: esta información se utilizará para la calibración del modelo. El archivo incluye 

dos pestañas, una de precipitaciones y otra de caudales registrados. Se ha seleccionado un 

intervalo temporal de una hora. 

 

6. Tratamiento de los datos de partida 

6.1. Pasos previos 

Paso 1. Creación de un proyecto en ArcGIS 

Creamos una carpeta de trabajo que llamamos EJERCICO_ALBERCHE y dentro de ella 

generamos un archivo con el nombre Alberche. Es importante que esta carpeta esté lo más 

próxima posible a la raíz C:\ y que no tenga espacios blancos ni tildes en el nombre. 

File → Save As 

 

Paso 2. Definición del sistema de coordenadas 

Pinchamos con el botón derecho del ratón, en la parte izquierda de la pantalla, sobre Layers. 
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Properties → Coordinate System → Projected Coordinated Systems → UTM → 
Europe → ETRS 1989 UTM Zone 30 N 

 

6.2. Definición de las características de la cuenca y las subcuencas 

6.2.1. Delimitación previa de subcuencas y líneas de drenaje 

Paso 1. Carga de los diferentes archivos del MDT 

File → Add Data → Add Data o  
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Paso 2. Unión de todos los archivos en uno único 

Abrimos ArcToolbox en el icono  

Data Management Tools → Raster → Raster Dataset → Mosaic to New Raster 

 

En Input Rasters seleccionamos los 24 archivos. 

En Output Location elegimos la carpeta de trabajo (EJERCICIO_ALBERCHE). 

En Raster Dataset Name with Extension damos el nombre al archivo (MDT_v1). 

En Number of Bands ponemos 1. 

En el resto de casillas dejamos los valores por defecto. 
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Paso 3. Eliminación de las depresiones del MDT 

Con este proceso se aumenta la cota de las celdas que están rodeadas completamente de celdas 

con mayor cota, asignando a dicha celda la menor cota de las celdas circundantes. 

En el menú de HEC-GeoHMS pinchamos en Preprocessing. 

Preprocessing → Fill Sinks 

 

En Input DEM seleccionamos MDT_v1. 

En Output Hydro DEM elegimos la carpeta de trabajo y el nombre del archivo (Fil_Alberche). 

Paso 4. Cálculo de las direcciones de flujo 

Se define la dirección de la mayor pendiente, evaluando celda a celda las cotas de las celdas 

circundantes a cada una de ellas. 
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Preprocessing → Flow Direction 

 
En Input Hydro DEM seleccionamos fil_alberche. 

En Output Flow Direction Grid elegimos la carpeta de trabajo y el nombre del archivo 

(Fdr_Alberche). 

Paso 5. Cálculo de la acumulación de flujo 

Se determina el número de celdas que drenan a cada celda, de manera que se puede calcular el 

área de drenaje de una celda dada multiplicando el número de celdas por el área de cada una. 

Preprocessing → Flow Accumulation 
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En Input Flow Direction Grid seleccionamos fdr_alberche. 

En Output Flow Accumulation Grid elegimos la carpeta de trabajo y el nombre del archivo 

(Fac_Alberche). 

Paso 6. Definición de tramos de cauce 
Preprocessing → Stream Definition 

 
En Input Flow Accumulation Grid seleccionamos fac_alberche. 

En Output Stream Grid elegimos la carpeta de trabajo y el nombre del archivo (Str_Alberche). 

Paso 7. División de los tramos en segmentos 

Preprocessing → Stream Segmentation 

 



Guía práctica sobre la modelización hidrológica y el modelo HEC-HMS. Parte 2 / 45 

Serie: Cuadernos de Geomática (Nº 4) 

En Input Stream Grid seleccionamos str_alberche. 

En Input Flow Direction Grid seleccionamos fdr_alberche. 

En Output Stream Link Grid elegimos la carpeta de trabajo y el nombre del archivo 

(strlnk_alber). 

Paso 8. Definición de la cuenca de cada tramo 

Preprocessing → Catchment Grid Delineation 

 
En Input Flow Direction Grid seleccionamos fdr_alberche. 

En Input Link Grid seleccionamos strlnk_alber. 

En Output Catchment Grid elegimos la carpeta de trabajo y el nombre del archivo  

(Cat_Alberche). 
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Paso 9. Definición de los polígonos de cada cuenca 

Preprocessing → Catchment Polygon Processing 

 

En Input Catchment Grid seleccionamos cat_alberche. 

En Output Catchment elegimos la carpeta de trabajo y el nombre del archivo (Catchment). 

Nótese que se ha creado la carpeta ALBERCHE.GDB. 

Paso 10. Definición de las líneas de drenaje 
Preprocessing → Drainage Line Processing 

 
En Input Stream Link Grid seleccionamos strlnk_alber. 

En Input Flow Direction Grid seleccionamos fdr_alberche. 

En Output Drainage Line elegimos la carpeta de trabajo y el nombre del archivo (DrainageLine). 
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Paso 11. Unión de subcuencas 

Preprocessing → Adjoint Catchment Processing 

 

En Input Drainage Line seleccionamos DrainageLine. 

En Input Catchment seleccionamos Catchment. 

En Output Adjoint Catchment elegimos la carpeta de trabajo y el nombre del archivo 

(AdjointCatchment). 

6.2.2. Delimitación definitiva de la cuenca y las subcuencas 

Paso 1. Creación de un proyecto nuevo 

En el menú de HEC-GeoHMS pinchamos en Project Setup. 

Project Setup → Start New Project 
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En Project Area damos el nombre a la cuenca (ProjectArea_Alberche). 

En Project Point damos el nombre del punto de cierre de la cuenca (ProjectPoint_Alberche). 

Al aceptar aparece el siguiente cuadro: 

 

En Project Name damos el nombre del proyecto (Alberche). 

En Description escribimos una pequeña descripción del proyecto. 

En Extraction Method seleccionamos Original Stream Definition. 

En Project Data Location seleccionamos Outside MainView Geodatabase y definimos la carpeta de 

trabajo (EJERCICIO_ALBERCHE). 
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Paso 2. Definición del punto de cierre de la cuenca 

En el menú de HEC-GeoHMS pinchamos en Add Project Point . 

Hacemos zoom hasta localizar el punto de cierre de la cuenca y pinchamos sobre él. 

 

En Point Name escribimos el nombre del punto (Outlet_Alberche). 

En Description escribimos una pequeña descripción del punto de cierre. 

Paso 3. Definición del nuevo proyecto 
Project Setup → Generate Project 
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Seleccionamos todos los archivos que hemos creado en los pasos anteriores: 

 Raw DEM: MDT_v1.  Stream Link Grid: strlnk_alber. 

 Hydro DEM: fil_alberche.  Catchment: Catchment. 

 Flow Direction Grid: fdr_alberche.  Adjoint Catchment: AdjointCatchment. 

 Flow Accumulation Grid: fac_alberche.  Project Area: ProjectArea_Alberche. 

 Stream Grid: str_alberche.  Project Point: ProjectPoint_Alberche. 

Al aceptar aparece otro cuadro donde debemos dar nombre a las capas de GIS: 

 
Damos los siguientes nombres: 

 MainViewDEM: MainViewDEM.  Stream Link Grid: StrLnk. 

 Raw DEM: RawDEM.  Catchment Grid: Cat. 

 Hydro DEM: Fil.  Subbasin: Subcuencas. 

 Flow Direction Grid: Fdr.  Project Point: Punto_cierre. 

 Flow Accumulation Grid: Fac.  River: Cauces. 

 Stream Grid: Str.  

Paso 4. Unión de subcuencas 

Si el programa genera un número elevado de subcuencas, podemos unificar varias en una sola. 

En este ejemplo vamos a dejar 13 subcuencas. La imagen de la izquierda muestra las cuencas que 

ha generado el programa y la imagen de la derecha, las 13 subcuencas que hemos dejado tras este 

proceso. 
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Seleccionamos las subcuencas a unir con la herramienta Select Features  

 

Y en el menú de Hec-GeoHMS pinchamos en Basin Processing. 
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Basin Processing → Basin Merge 

 

Repetir el mismo proceso con todas las subcuencas con cuidado, ya que algunas son muy 

pequeñas y difíciles de apreciar. En este caso, es más sencillo identificar estas pequeñas cuencas 

en la tabla de atributos de la capa que gráficamente. 

Paso 5. Cambio de nombre de las subcuencas 

Para facilitar la identificación de las subcuencas vamos a modificar sus nombres. 

Editor → Start Editing 
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Seleccionamos la capa Subcuencas. 

 

Abrimos la tabla de atributos de la capa Subcuencas. 

Open Attribute Table 
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Modificamos los nombres de la columna Name según el siguiente mapa. Los nombres 

asignados coinciden con su cauce más importante. 
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Finalmente guardamos los cambios: 

Editor → Save Edits 

 

Y cerramos la edición. 

Editor → Stop Editing 
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6.2.3. Definición de las características físicas de la cuenca y las subcuencas 

Paso 1. Cálculo de la longitud del cauce más largo de las subcuencas 

Este proceso nos servirá para determinar el tiempo de concentración posteriormente. 

En el menú de Hec-GeoHMS pinchamos en Characteristics. 

Characteristics → Longest Flow Path 

 

En Input Raw DEM seleccionamos RawDEM. 

En Input Flow Direction Grid seleccionamos Fdr. 

En Input Subbasin seleccionamos Subcuencas. 

En Output Longest Flow Path damos el nombre al archivo (LongestFlowPathAlb). 
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Paso 2. Cálculo del centroide de cada subcuenca 

Characteristics → Basin Centroid 

 

En Select Centroid Method seleccionamos Center of gravity. 

En Input Subbasin seleccionamos Subcuencas. 

En Output Centroid damos el nombre al archivo (CentroidAlb). 

Paso 3. Cálculo del centroide del cauce más largo 
Characteristics → Centroidal Longest Flowpath 
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En Input Subbasin seleccionamos Subcuencas. 

En Input Centroid seleccionamos CentroidAlb. 

En Input Longest Flow Path seleccionamos LongestFlowPathAlb. 

En Output Centroidal Longest Flow Path damos el nombre al archivo 

(CentroidalLongestFlowPathAlb). 

 

Se pueden realizar otros procesos con las subcuencas y los tramos de cauces, como dividir 

cuencas, sacar perfiles de los cauces, calcular longitudes de cauces principales, etc, pero en este 

ejemplo sólo se han visto las herramientas que nos generarán los datos necesarios para las 

siguientes fases.  

 

6.2.4. Definición de los parámetros hidrológicos 

Paso 1. Definición de los procesos de cálculo de HEC-HMS 

En el menú de Hec-GeoHMS pinchamos en Parameters. 

Parameters → Select HMS Processes 

 

En Input Subbasin seleccionamos Subcuencas. 

En Input River seleccionamos Cauces. 

En Subbasin - Loss Method seleccionamos SCS. 

En Subbasin - Transform Method seleccionamos SCS. 

En Subbasin - Baseflow Method seleccionamos Recession. 

En River - Route Method seleccionamos Muskingum Cunge. 
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Paso 2. Asignación automática de nombre a los cauces 

Parameters → River Auto Name 

 

En Input River seleccionamos Cauces. 

Paso 3. Asignación automática de nombre a las subcuencas 
Parameters → Basin Auto Name 

 

En Input Subbasin seleccionamos Subcuencas. 
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6.2.5. Definición de las entradas a HEC-HMS 

Paso 1. Definición de los archivos de entrada y el sistema de unidades 

En el menú de Hec-GeoHMS pinchamos en HMS. 

HMS → Map to HMS Units 

 

En Raw DEM seleccionamos RawDEM. 

En Subbasin seleccionamos Subcuencas. 

En Longest Flow Path seleccionamos LongestFlowPathAlb. 

En Centroidal Longest Flow Path seleccionamos CentroidalLongestFlowPathAlb. 

En River seleccionamos Cauces. 

En Centroid seleccionamos CentroidAlb. 

En el cuadro que aparece a continuación se selecciona el Sistema Internacional de unidades. 
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Paso 2. Comprobación de los datos para HMS 
HMS → HMS Check Data 

 

En River seleccionamos Cauces. 

En Subbasin seleccionamos Subcuencas. 

En Centroid seleccionamos CentroidAlb. 

En Project Point seleccionamos Punto_cierre. 
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Paso 3. Definición del esquema de HMS 

HMS → HMS Schematic 

 

En Project Point seleccionamos Punto_cierre. 

En Centroid seleccionamos CentroidAlb. 

En River seleccionamos Cauces. 

En Subbasin seleccionamos Subcuencas. 

En HMS Link damos el nombre HMSLink. 

En HMS Node damos el nombre HMSNode. 
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Paso 4. Definición de la leyenda HMS 

HMS → Toggle HMS Legend → HMS Legend 

 
 

Paso 5. Introducción de las coordenadas 

HMS → Add Coordinates 

 

En Raw DEM seleccionamos RawDEM. 
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En HMS Node seleccionamos HMSNode. 

En HMS Link seleccionamos HMSLink. 

Paso 6. Preparación de los datos a exportar 

HMS → Prepare Data for Model Export 

 

En Subbasin seleccionamos Subcuencas. 

En River seleccionamos Cauces. 

En Longest Flow Path seleccionamos LongestFlowPathAlb. 

En Centroidal Longest Flow Path seleccionamos CentroidalLongestFlowPathAlb. 
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Paso 7. Definición de la imagen de fondo 

HMS → Background Shape File 

 

En Subbasin seleccionamos Subcuencas. 

En River seleccionamos Cauces. 

Paso 8. Definición del archivo del modelo de cuenca 
HMS → Basin Model File 
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6.3. Resumen de las características de las subcuencas 

En este apartado vamos a anotar los datos de superficie, longitud del cauce más largo y 

pendiente del mismo. Con los dos últimos valores podremos calcular el tiempo de concentración 

y el tiempo de retardo. 

Paso 1. Visualización de las superficies de las subcuencas 

Abrimos la tabla de atributos de la capa Subcuencas pinchando con el botón derecho sobre la 

misma. 

Open Attribute Table 

 

Y anotamos los valores de la columna Shape_Area 
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Las superficies de cada subcuenca se recogen en la siguiente tabla: 

Subcuenca Área (km2) 

Cabecera 247,019 

Piquillo 373,494 

Royal 247,722 

Gaznata 171,348 

Tórtolas 372,792 

Cofio 638,653 

Perales 527,372 

Berciana 413,444 

Tordillos 113,519 

Pedrillán 189,428 

Parra 168,171 

Molinillo 215,719 

Marigarcía 147,572 

 

Paso 2. Visualización de la longitud y la pendiente de los cauces más largos 

Abrimos la tabla de atributos de la capa LongestFlowPathAlb pinchando con el botón 

derecho sobre la misma. 

Open Attribute Table 
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Y anotamos los valores de las columnas Shape_Lenght y Slp. 

 

 

En este caso no existe ningún campo que nos indique a qué subcuenca pertenece cada cauce, 

por lo que deberemos ir seleccionándolos de uno en uno en la tabla y viendo su situación sobre el 

mapa. 
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Paso 3. Cálculo del tiempo de concentración y el tiempo de retardo 

Para calcular el tiempo de concentración y el tiempo de retardo a partir de los valores de 

longitud y pendiente de cauce utilizaremos las siguientes fórmulas: 

Tiempo de concentración 

Es el tiempo que tarda el agua en discurrir desde el punto más alejado de la cuenca hasta el 

punto de salida. Para calcularlo utilizaremos la fórmula de Témez: 

 

Tୡ ൌ ቈ0,3 ൬
L
i଴,ଶହ

൰
଴,଻଺

቉ 

donde: 

 Tc: tiempo de concentración, en horas. 

 L: longitud del recorrido más largo del agua en la subcuenca, en km. 

 i: pendiente media del recorrido más largo en la subcuenca, en m/m. 

 

Tiempo de retardo 

Es el tiempo transcurrido desde el centro de gravedad del hietograma de precipitación neta 

hasta la punta del hidrograma. Este valor se estima para cada una de las subcuencas y es función 

del tiempo de concentración: 

T୪ୟ୥ ൎ 0,6 ൉ Tୡ 

 

La siguiente tabla incluye los valores de longitud y pendiente de cada cauce, así como del 

tiempo de concentración y el tiempo de retardo: 

 

Subcuenca Longitud (km) Pendiente (m/m) Tc (h) Tlag (h) 

Cabecera 35,571 0,0224 9,32 5,59 

Piquillo 37,584 0,0321 9,08 5,45 

Royal 29,187 0,0288 7,65 4,59 

Gaznata 33,445 0,0242 8,76 5,26 

Tórtolas 50,168 0,0169 12,77 7,66 

Cofio 61,518 0,0212 14,28 8,57 

Perales 48,300 0,0205 11,96 7,18 

Berciana 42,357 0,0061 13,63 8,18 

Tordillos 24,715 0,0185 7,33 4,40 

Pedrillán 34,984 0,0166 9,74 5,85 

Parra 30,682 0,0212 8,42 5,05 

Molinillo 37,692 0,0061 12,47 7,48 

Marigarcía 32,140 0,0051 11,43 6,86 
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6.4. Cálculo del Flujo Base 

Paso 1. Creación de un nuevo Data Frame 

Para facilitar el trabajo con los diferentes archivos GIS creamos un conjunto de capas (Data 

Frame) que llamaremos Flujo Base y trabajaremos dentro de él. 

Insert → Data Frame 

 

Paso 2. Carga del archivo ráster de escorrentía total anual y la capa de subcuencas 

File → Add Data → Add Data o  
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Paso 3. Cruce de ambas capas 

Al cruzar las capas se recorta el modelo ráster según la geometría de cada subcuencas.  

En primer lugar seleccionamos la subcuenca que queremos cruzar mediante la herramienta 

Select Features . En el ejemplo se ha seleccionado la subcuenca Cabecera. 
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Y después utilizamos la herramienta Extract by Mask de ArcToolbox  

ArcToolbox → Spatial Analyst Tools → Extraction → Extract by Mask 

 

En Input raster seleccionamos aes4005. 

En Input raster or feature mask data seleccionamos Subcuencas. 

En Output raster damos nombre al archivo (FB_Cabecera). 

Repetimos el proceso con las otras 12 subcuencas. 

Paso 4. Cálculo del caudal asociado al flujo base 

En primer lugar obtenemos el valor medio de todos los valores de las celdas. Para ello 

entramos en las propiedades de la capa pinchando con el botón derecho sobre la misma. 
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Layer Properties → Source →Statistics → Mean 

 
 

Según los resultados, el valor medio de escorrentía de la subcuenca Cabecera es de 267,41 

mm/año. Conociendo la superficie de la subcuenca (247,019 km2) y el tamaño de las celdas (1 x 1 

km) se obtiene el Flujo Base (2,095 m3/s). 

Los resultados para el resto de subcuencas son: 

 

Subcuenca 
Escorrentía 

media (mm/año)
Área (km2) 

Caudal 

inicial (m3/s) 

Cabecera 267,41 247,019 2,095 

Piquillo 298,84 373,494 3,539 

Royal 342,83 247,722 2,693 

Gaznata 186,79 171,348 1,015 

Tórtolas 180,71 372,792 2,136 

Cofio 256,46 638,653 5,194 

Perales 89,14 527,372 1,491 

Berciana 56,70 413,444 0,743 

Tordillos 161,77 113,519 0,582 

Pedrillán 102,80 189,428 0,617 

Parra 109,07 168,171 0,582 

Molinillo 52,90 215,719 0,362 

Marigarcía 58,99 147,572 0,276 
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6.5. Cálculo del Número de Curva de las subcuencas 

Para calcular el número de curva se utilizará el método desarrollado en el artículo "Generación 

automática del número de curva con sistemas de información geográfica" (Ferrer et al. 1995), que 

se basa en asignar un número primo a cada variable que interviene en el proceso hidrológico 

(pendiente, tipos de suelos y usos del suelo).  

 

6.5.1. Elaboración de mapa de pendientes 

Se asignarán los siguientes códigos: 

 

Pendiente Código 

< 3% 1 

≥ 3% 2 

 

Paso 1. Creación de un nuevo Data Frame 

Para facilitar el trabajo con los diferentes archivos GIS creamos un conjunto de capas (Data 

Frame) que llamaremos Número Curva y trabajaremos dentro de él. 

Insert → Data Frame 
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Paso 2. Carga del archivo ráster del MDT y la capa de subcuencas 

File → Add Data → Add Data o  

 
 

 

Paso 3. Cruce de ambas capas 

Al cruzar las capas se recorta el modelo ráster según la geometría de cada subcuencas. Para 

ello utilizamos la herramienta Extract by Mask de ArcToolbox  
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ArcToolbox → Spatial Analyst Tools → Extraction → Extract by Mask 

 

En Input raster seleccionamos mdt_v1. 

En Input raster or feature mask data seleccionamos Subcuencas. 

En Output raster damos nombre al archivo (MDT_cuenca). 

Paso 4. Creación del mapa de pendientes 

Utilizamos la herramienta Slope de ArcToolbox  

ArcToolbox → Spatial Analyst Tools → Surface → Slope 
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En Input raster seleccionamos MDT_cuenca. 

En Output raster damos nombre al archivo (Pendientes). 

En Output measurement (optional) seleccionamos PERCENT_RISE, para que las pendientes 

vengan expresadas en porcentaje. 

Paso 5. Reclasificación de las pendientes 

Reclasificamos las pendientes en mayores y menores del 3 %. 

Utilizamos la herramienta Reclassify de ArcToolbox  

ArcToolbox → Spatial Analyst Tools → Reclass → Reclassify 

 

En Input raster seleccionamos Pendientes. 

En Reclass Field seleccionamos Value. 

En la tabla de Reclassification introducimos los nuevos intervalos. Para ello pinchamos en Add 

Entry. 

En Output raster damos nombre al archivo (Pendientes_v1). 
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Paso 6. Conversión del fichero a formato vectorial 

ArcToolbox → Conversion Tools → From Raster → Raster to Polygon 

 

En Input raster seleccionamos Pendientes_v1. 

En Field (optional) seleccionamos Value. 

En Output polygon features damos nombre al archivo (Pendientes_NC). 

 

6.5.2. Elaboración de mapa de usos del suelo 

En primer lugar es necesario establecer la correspondencia entre los usos del suelo del 

CORINE y los del SCS. Esta correspondencia se ha obtenido del artículo "Aportación de la 

teledetección para la determinación del parámetro hidrológico del número de curva" (Ferrer et al. 

1998). Los tipos de usos del suelo localizados en la zona de estudio y sus códigos asociados se 

encuentran en el archivo Correspondencia_usos_suelo.xlsx. 
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Paso 1. Carga la capa de usos del suelo 

Los usos del suelo se encuentran en el archivo CLC06_es.shp. 

File → Add Data → Add Data o  

 

Paso 2. Recorte con la capa de subcuencas 

Utilizamos la herramienta Clip de Geoprocessing. 

Geoprocessing → Clip 

 

En Input Features seleccionamos CLC06_es. 
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En Clip Features seleccionamos Subcuencas. 

En Output Features Class damos nombre al archivo (Usos_suelo). 

Paso 3. Asignación de códigos a los usos del suelo 

Para ello realizamos una asociación entre los códigos del mapa del CORINE y los códigos del 

método de los números primos, mediante la tabla Correspondencia_usos_suelo.xlsx. 

Pinchamos con el botón derecho sobre la capa Usos_suelo: 

Joins and Relates → Join 
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En el punto 1 seleccionamos el campo de la capa Usos_suelo que queremos utilizar para 

realizar la unión (code_06). 

En el punto 2 seleccionamos el archivo (Correspondencia_usos_suelo.xlsx) y la pestaña del 

mismo (Usos_suelo) donde se encuentra la relación entre los códigos. 

En el punto 3 seleccionamos la columna de la tabla con la que se realizará la unión (code_06). 

 

6.5.3. Elaboración de mapa de grupos hidrológicos 

Se asignarán los siguientes códigos: 

 

Grupo hidrológico Código

A 3 

B 5 

C 7 

D 11 

 

Según la nueva Norma 5.2-IC de Drenaje Superficial, toda la cuenca de estudio se encuentra 

en zona B, por lo que el código asignado es el 5. Al tener toda la cuenca el mismo código, no es 

necesario elaborar el mapa correspondiente. Este valor se tendrá en cuenta al multiplicar los 

valores de los diferentes parámetros. 

 

6.5.4. Asignación de valores del método de números primos 

Paso 1. Cruce de mapas 

En primer lugar cruzamos las capas de usos del suelo y de pendientes. 

Geoprocessing → Intersect 
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En Input Features seleccionamos las capas que queremos cruzar (Usos_suelo y 

Pendientes_NC). 

En Output Features Class damos nombre al archivo (Numero_Curva). 

Paso 2. Creación de un campo para el código final del método de números primos 

Abrimos la tabla de atributos de la capa Numero_Curva pinchando con el botón derecho 

sobre la misma. 

 

Añadimos la nueva columna. 

Table → Add Field... 
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Definimos las características del campo 

 

En Name damos el nombre al nuevo campo (Cod_prim). 

En Type seleccionamos Short Integer. 

En Fields Properties, Precision, marcamos el número de decimales (0). 

Paso 3. Cálculo del código final del método de números primos 

El código se obtiene multiplicando los valores asignados a las pendientes, los usos del suelo y 

los grupos hidrológicos. 

Dentro de la capa Numero_Curva, el código de la pendiente está en el campo GRIDCODE, 

el del uso del suelo está en el campo Usos_su_10 y el del grupo hidrológico, como se ha 

comentado anteriormente, es 5 para toda la cuenca. 

Para realizar la multiplicación de los valores, pinchamos con el botón derecho sobre la 

columna Cod_prim y seleccionamos Field Calculator. 
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Indicamos la operación a realizar: 

Cod_prim=[GRIDCODE]*[Usos_su_10]*5 

 

6.5.5. Asignación de valores de Número de Curva 

Mediante la tabla auxiliar Número_curva.xlsx asignamos el valor de cada código del método 

de números primos a un valor de número de curva. 
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Paso 1. Unión de tablas 

Pinchamos con el botón derecho sobre la capa Numero_Curva: 

Joins and Relates → Join 

 
 

 

En el punto 1 seleccionamos el campo de la capa Numero_Curva que queremos utilizar para 

realizar la unión (Cod_prim). 

En el punto 2 seleccionamos el archivo (Número_curva.xlsx) y la pestaña del mismo 

(Numero_curva) donde se encuentra la relación entre los códigos. 
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En el punto 3 seleccionamos la columna de la tabla con la que se realizará la unión (Producto 

numeros primos). 

Paso 2. Cruce de la capa del Número de Curva y de las subcuencas 

Como cada subcuenca va a tener su propio valor de número de curva, es necesario cruzar el 

mapa completo de números de curva con cada una de las subcuencas. 

Geoprocessing → Intersect 

 
 

En Input Features seleccionamos las capas que queremos cruzar (Subcuencas y 

Numero_Curva). 

En Output Features Class damos nombre al archivo (NC_Subcuencas). 

Paso 3. Cálculo del número de curva por subcuenca 

Abrimos con Excel el archivo NC_Subcuencas.dbf. En la tabla de registros, separamos por 

subcuenca y multiplicamos el valor del número de curva por la superficie de cada registro. 

Finalmente sumamos estos productos y lo dividimos entre la superficie total de la subcuenca para 

calcular la media ponderada. 

Los resultados obtenidos para cada subcuenca son: 

 

Subcuenca Número Curva 

Cabecera 59,07 

Piquillo 61,47 

Royal 60,64 

Gaznata 59,79 

Tórtolas 61,05 
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Subcuenca Número Curva 

Cofio 58,62 

Perales 63,59 

Berciana 63,58 

Tordillos 62,56 

Pedrillán 62,68 

Parra 60,33 

Molinillo 70,61 

Marigarcía 69,85 

 

6.6. Definición de la geometría de los cauces 

Según el método de tránsito de hidrogramas que vamos a utilizar (Muskingum - Cunge), cada 

tramo del cauce principal queda definido por su sección transversal característica, su pendiente, 

su longitud y la rugosidad del lecho (expresadas como el número n de Manning). Si bien la 

delimitación de cada tramo de cauce (Reach) puede observarse en los apartados correspondientes 

al modelo HEC-HMS, se ha creído conveniente explicar aquí la manera de obtener sus 

características mediante ArcGIS. En total se han definido ocho tramos de cauce, como se verá 

más adelante. 

Paso 1. Definición de la sección transversal característica 

En primer lugar seleccionamos la capa del Modelo Digital del Terreno (MDT_v1) dentro de 

3D Analyst. 
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Marcamos la línea por la cual se trazará la sección transversal mediante la herramienta 

Interpolate Line , dentro de 3D Analyst. 

 

Para ello hacemos zoom sobre la zona en cuestión. Y para marcar el punto final es necesario 

hacer doble click. 

Mediante la herramienta Profile Graph , dentro de 3D Analyst, podemos observar el perfil 

generado. 
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Pinchando con el botón derecho sobre el título del gráfico podemos exportar a Excel las 

coordenadas x, y de cada punto. 

 

En la pestaña Data seleccionamos Excel y posteriormente la ruta donde se guardará el archivo. 
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Del total de puntos que definen la sección tenemos que elegir solamente ocho, que son los 

que se introducirán en HEC-HMS. En el archivo Muskingum-Cunge.xlsx se encuentran los ocho 

puntos seleccionados para cada tramo, además del resto de características que definen cada 

sección y que se calculan en los siguientes pasos. 

Paso 2. Cálculo de la longitud del tramo 

La capa DrainageLine contiene pequeños segmentos de cauce, definidos entre dos puntos de 

incorporación de afluentes. Para conocer la longitud total de cada uno de nuestros tramos 

debemos sumar estos segmentos. 

Para consultar la longitud de cada segmento utilizamos la herramienta Identify  y pinchamos 

sobre el tramo. 
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La longitud del segmento se encuentra en el campo Shape_Lenght. En el archivo Muskingum-

Cunge.xlsx se encuentra la longitud de cada tramo, una vez sumados los diferentes segmentos. 

Paso 3. Cálculo de la pendiente del tramo 

Como ya hemos medido la longitud de cada tramo, sólo tenemos que calcular el desnivel del 

tramo para obtener la pendiente. 

Para ello consultamos la cota del punto inicial y final con la herramienta Identify  en la capa 

del MDT (MDT_v1). 
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La cota de cada punto se encuentra en el campo Pixel value. En el archivo Muskingum-

Cunge.xlsx se encuentran las cotas inicial y final y el cálculo de la pendiente para los ocho tramos. 

Paso 4. Definición del número n de Manning 

Para definir el coeficiente de rugosidad de cada tramo es importante conocer datos del cauce 

como su morfología y la presencia/ausencia de vegetación y/o piedras. Esta información puede 

obtenerse directamente realizando una visita de campo, aunque pueden hacerse estimaciones 

mediante la visualización de fotografías aéreas. En este estudio se han utilizado las tablas incluidas 

en el libro "Hidráulica de Canales Abiertos" (Chow, 1994). 

Los coeficientes seleccionados para cada tramo, así como su justificación se encuentran en el 

archivo Muskingum-Cunge.xlsx. 

 

6.7. Definición de los hietogramas 

Debido a lo laborioso de la elaboración del estudio pluviométrico, para la realización de este 

ejercicio vamos a facilitar los hietogramas de diseño para cada subcuenca, si bien se indica a 

continuación un método para obtenerlos: 

1 Búsqueda de las estaciones meteorológicas que existen dentro de la cuenca. Para ello 

utilizamos la página del SIGA (Sistema de Información Geográfica de Datos Agrarios): 

http://sig.mapama.es/siga/. Entre la información de partida se incluye un archivo shp con las 

estaciones existentes dentro de la cuenca (Estaciones_ETRS89).  

2 Solicitud de los datos de Precipitación Máxima Diaria Mensual a la AEMET. 

3 Análisis de la calidad de los datos. Para ello se utiliza el método de las dobles 

acumulaciones mediante el programa CHAC, programa gratuito creado por el CEDEX (2013). 

Con este análisis se descartan aquellas estaciones que no tengan una serie lo suficientemente larga 

(al menos 25 años consecutivos) o que tengan demasiadas ausencias de datos. 

4 Completado de datos. Se rellenan las lagunas puntuales existentes en los datos recibidos, 

también mediante el programa CHAC, empleando el método de correlación múltiple. 

5 Análisis estadístico de las precipitaciones. Se calculan las leyes de frecuencia de Gumbel, 

Normal, Log-Pearson III y GEV con CHAC. Como valor final se adopta la media aritmética 

entre las cuatro leyes. 

6 Bondad de ajuste de las leyes de frecuencia. Se realiza el test de Kolmogorov-Smirnov 

para cada ley, considerando un grado de confiabilidad del 95 %. Este test se realiza con el 

software EASYFIT, despreciando aquellas leyes que no pasen el test. 

7 Distribución espacial de precipitaciones. Mediante ArcGIS se aplica el método de los 

polígonos de Thiessen, ponderando las precipitaciones en función del área de influencia de cada 

estación. 

8 Distribución temporal de precipitaciones. Consiste en determinar el hietograma de diseño 

para cada subcuenca. Se aplica el método de los bloques alternos, para lo cual es necesario 

elaborar las curvas IDF, con el apoyo de la fórmula que establece la Instrucción 5.2-IC de 

Drenaje Superficial de Carreteras para el cálculo de intensidades de lluvia. 
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Los hietogramas de cada subcuenca se faciltan entre los datos de partida, en el archivo 

Hietogramas.xlsx. 

 

7. Elaboración del modelo HEC-HMS 

7.1. Creación del modelo HEC-HMS 

Paso 1. Creación del archivo HEC-HMS 
Abrimos HEC-HMS y creamos un proyecto nuevo.  

File → New... 

 

En Name damos un nombre al proyecto (HMS_Alberche). 

En Description escribimos una pequeña descripción del proyecto. 

En Location buscamos la carpeta donde queremos guardar el proyecto 

(EJERCICIO_ALBERCHE). 

En Default Unit System seleccionamos el sistema de unidades (Metric). 
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Paso 2. Importación de los datos generados en HEC-GeoHMS 

Buscamos el modelo de cuenca generado en HEC-GeoHMS 

(C:\EJERCICIO_ALBERCHE\Alberche).  

File → Import → Basin Model... 

 
Paso 3. Carga del mapa de fondo 

View → Background Maps →Add 
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Buscamos las capas shp de Subcuencas y Cauces generadas con HEC-GeoHMS 

(C:\EJERCICIO_ALBERCHE\Alberche). 

Paso 4. Simplificación del modelo 

Hec-GeoHMS ha creado un total de 15 tramos de cauce, pero para simplificar el ejercicio nos 

vamos a quedar sólo con 8. Es importante que al eliminar cada tramo definamos la conexión al 

modelo por la parte de aguas abajo. Para ello pinchamos sobre el tramo que ha quedado 

desconectado y en la pestaña Reach seleccionamos la unión en Downstream. Lo mismo sucede con 

las subcuencas, que al eliminar elementos debe comprobarse su conexión aguas abajo. 

También vamos a modificar los nombres de los tramos de cauce y las uniones dando valores 

de 1 a 8 de aguas arriba a aguas abajo. El esquema final queda de la siguiente manera: 

 
 

7.2. Modelo de cuenca (Basin Model) 

7.2.1. Caracterización de las subcuencas 

A continuación se incluye la caracterización de la subcuenca Cabecera. El mismo proceso debe 

repetirse para las otras doce subcuencas. 

Paso 1. Completado de la pestaña Subbasin 

Como se ha comentado anteriormente, en la pestaña Subbasin seleccionamos los métodos de 

cálculo y otros valores de cada subcuenca: 

 Area (KM2): superficie de la cuenca en km2. 

 Latitude Degrees, Latitude Minutes, Latitude Seconds, Longitude Degrees, Longitude Minutes, 

Longitude Seconds: lo dejamos en blanco. 

 Canopy Method: --None--. 

 Surface Method: --None--. 

 Loss Method: SCS Curve Number. 
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 Transform Method: SCS Unit Hydrograph. 

 Baseflow Method: Recession. 

 

Paso 2. Completado de la pestaña Loss 

 Initial Abstraction (MM): dejamos la casilla en blanco. 

 Curve Number: número de curva previamente calculado. 

 Impervious (%): porcentaje de la cuenca que es impermeable. Como la impermeabilidad de 

la cuenca se tiene en cuenta dentro del valor del número de curva, ponemos un 0.0 %. 
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Paso 3. Completado de la pestaña Transform 

 Graph Type: seleccionamos Standard (PRF-484). 

 Lag Time (MIN): tiempo de retardo previamente calculado. 

 

Paso 4. Completado de la pestaña Baseflow 

 Initial Type: seleccionamos Discharge. 

 Initial Discharge (M3/S): flujo base previamente calculado. 

 Recession Constant: suele utilizarse un valor de 0.6. 

 Threshold Type: seleccionamos Threshold Discharge. 

 Flow (M3/S): volvemos a introducir el flujo base. 
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Paso 5. Completado de la pestaña Options 

 Observed Flow: --None--. 

 Observed Stage: --None--. 

 Observed SWE: --None--. 

 Elev-Discharge: --None--. 

 Ref Flow (M3/S): lo dejamos en blanco. 

 Ref Label: lo dejamos en blanco. 

 
7.2.2. Caracterización de los tramos 

Paso 1. Definición de las secciones transversales 
Components → Paired Data Manager  
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En Data Type seleccionamos Cross Sections. Y pinchando en New damos nombre a la sección. 

 

Al crear la sección, en la parte izquierda de la pantalla, se genera la carpeta Paired Data. Y 

dentro de ésta, la subcarpeta Cross Sections. 

En la pestaña Paired Data se define: 

 Description: es la descripción que se ha dado al generar la sección. 

 Data Source: seleccionamos Manual Entry. 

 Units: seleccionamos las unidades de medida (M:M). 
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En la pestaña Table se introducen los 8 puntos que definen la sección transversal. Estos datos 

se encuentran dentro del archivo Muskingum-Cunge.xlsx. 

 
 

En la pestaña Graph se puede observar gráficamente la sección transversal definida. 

 

El proceso se repite para las ocho secciones transversales, una para cada tramo. 
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Paso 2. Completado de la pestaña Reach 

Se selecciona cada uno de los tramos y se definen sus características. 

 Description: descripción del tramo. 

 Downstream: indica el nodo de conexión aguas abajo. Como el modelo ya está generado, 

no es necesario modificar este campo. 

 Routing Method: seleccionamos Muskingum-Cunge. 

 Loss/Gain Method: --None--. 

 
 

Paso 3. Completado de la pestaña Routing 

 Time Step Method: seleccionamos Automatic Fixed Interval. 

 Length (M): longitud del tramo. Se obtiene del archivo Muskingum-Cunge.xlsx. 

 Slope (M/M): pendiente del tramo. Se obtiene del archivo Muskingum-Cunge.xlsx. 

 Manning´s n: coeficiente de rugosidad de Manning. Se obtiene del archivo Muskingum-

Cunge.xlsx. 

 Invert (M): es la cota. Lo dejamos en blanco. 

 Shape: seleccionamos Eight Point. 

 Left Manning´s n: coeficiente de rugosidad de Manning de la margen izquierda. Consideramos el mismo 

valor que en el cauce. 

 Right Manning´s n: coeficiente de rugosidad de Manning de la margen derecha. Consideramos el mismo 

valor que en el cauce. 

 Cross Section: seleccionamos la sección transversal previamente generada. 
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Paso 4. Completado de la pestaña Options 

 Observed Flow: --None--. 

 Observed Stage: --None--. 

 Elev-Discharge: --None--. 

 Ref Flow (M3/S): lo dejamos en blanco. 

 Ref Label: lo dejamos en blanco. 
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7.2.3. Caracterización de las confluencias 

Paso 1. Completado de la pestaña Junction 

 Description: descripción del elemento. 

 Downstream: indica el nodo de conexión aguas abajo. Como el modelo ya está generado, 

no es necesario modificar este campo. 

 

Paso 2. Completado de la pestaña Options 

 Observed Flow: --None--. 

 Observed Stage: --None--. 

 Elev-Discharge: --None--. 

 Ref Flow (M3/S): lo dejamos en blanco. 

 Ref Label: lo dejamos en blanco. 



104/ J.A. Pascual Aguilar, M. Díaz Martín 

Series: Notes on Geomatics (Nº 4) 

 
 

7.2.4. Caracterización de la salida 

Paso 1. Completado de la pestaña Sink 

 Description: descripción del elemento. 

 Downstream: como se trata del nodo de salida, no hay más elementos aguas abajo, por lo 

que seleccionamos --None--. 
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Paso 2. Completado de la pestaña Options 

 Observed Flow: --None--. 

 Observed Stage: --None--. 

 Elev-Discharge: --None--. 

 Ref Flow (M3/S): lo dejamos en blanco. 

 Ref Label: lo dejamos en blanco. 

 

7.3. Modelo meteorológico (Meteorologic Model) 

Paso 1. Creación de los hietogramas de diseño 

Components → Time-Series Data Manager  
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En Data Type seleccionamos Precipitation Gages. Y pinchando en New damos nombre al 

hietograma. 

 

Al crear el hietograma, en la parte izquierda de la pantalla, se genera la carpeta Time-Series Data. 

Y dentro de ésta, la subcarpeta Precipitation Gages. 

En la pestaña Time-Series Gage se define: 

 Description: es la descripción que se ha dado al generar el hietograma. 

 Data Source: seleccionamos Manual Entry. 

 Units: seleccionamos las unidades de medida (Incremental Milimeters). 

 Time Interval: seleccionamos el intervalo del hietograma (2 Hours). 

 Latitude Degrees, Latitude Minutes, Latitude Seconds, Longitude Degrees, Longitude Minutes, 

Longitude Seconds: lo dejamos en blanco. 
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En la pestaña Time Window se define: 

 Start Date (ddMMMYYYY): es la fecha de comienzo de la precipitación. Dejamos la fecha 

que viene por defecto (01ene2000). 

 Start Time (HH:mm): es la hora de comienzo de la precipitación. Dejamos la fecha que viene 

por defecto (00:00). 

 End Date (ddMMMYYYY): es la fecha de finalización de la precipitación. Como nuestros 

hietogramas tienen 24 horas, ponemos el día 02ene2000. 

 End Time (HH:mm): es la hora de finalización de la precipitación. Como nuestros hietogramas 

tienen 12 bloques, ponemos las 00:00. De este modo se creará una tabla con 12 intervalos de 

2 horas cada uno, que coincide con los hietogramas generados. 
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En la pestaña Table introducimos los valores de cada bloque, que se encuentran en el archivo 

Hietogramas.xlsx. 
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En la pestaña Graph se puede observar gráficamente el hietograma. 

 

El proceso se repite para cada una de las subcuencas. 

Paso 2. Creación del modelo meteorológico 

Components → Meteorologic Model Manager 
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Pinchando en New damos nombre al modelo. 

 

Al crear el modelo, en la parte izquierda de la pantalla, se genera la carpeta Meteorologic Models. 

Paso 3. Asociación de hietogramas a las subcuencas 

Pinchando sobre el modelo meteorológico generado (Alberche), en la pestaña Meteorology Model 

definimos: 

 Description: es la descripción que se ha dado al generar el modelo meteorológico. 

 Shortwave: --None--. 

 Longwave: --None--. 

 Precipitation: seleccionamos Specified Hyetograph. 

 Evapotranspiration: --None--. 

 Snowmelt: --None--. 

 Unit System: seleccionamos el sistema de medida (Metric). 

 Replace Missing: seleccionamos Abort Compute. 
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En la pestaña Basins seleccionamos Yes, dentro de Include Subbasins, para asignar el modelo de 

cuenca al modelo meteorológico. 
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En la pestaña Options seleccionamos No, dentro de Total Override. 

 
 

Para asignar el hietograma a cada subcuenca pinchamos sobre Specified Hyetograph y realizamos 

la asignación. 
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7.4. Especificaciones de control (Control Specifications) 

Paso 1. Creación de las especificaciones de control 

Components → Control Specifications Manager 

 

 

Pinchando en New damos nombre a las especificaciones de control. 
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Al crear las especificaciones, en la parte izquierda de la pantalla, se genera la carpeta Control 

Specifications. 

 

En la pestaña Control Specifications se define: 

 Description: es la descripción que se ha dado al generar las especificaciones de control. 

 Start Date (ddMMMYYYY): es la fecha de comienzo del cálculo (01ene2000). 

 Start Time (HH:mm): es la hora de comienzo del cálculo (00:00). 

 End Date (ddMMMYYYY): es la fecha de finalización del cálculo (03ene2000). 

 End Time (HH:mm): es la hora de finalización del cálculo (00:00). 

 Time Interval: seleccionamos 1 Hour. 

El periodo de cálculo debe definirse con el margen suficiente para incluir el periodo de las 

precipitaciones más el tiempo que tarda en alcanzarse el pico del hidrograma. En este caso se han 

establecido dos días de cálculo. 

 

8. Calibración 

La calibración consiste en buscar los parámetros hidrológicos dentro de cada subcuenca o 

tramo de río que minimicen el error entre los valores observados y los valores calculados. Para 

ello, lo ideal sería utilizar una estación de aforos situada lo más próxima posible al punto final de 

la cuenca, pero en este caso existen hasta cuatro embalses dentro de la misma, por lo que no se 

reflejaría el comportamiento de la cuenca en condiciones naturales. Por tanto, se ha decidido 

utilizar la estación del SAIH AR22 Cofio en San Martín, ya que, aunque no abarca toda la cuenca, 

no posee ningún embalse aguas arriba y las condiciones son naturales. 
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Dentro de las diferentes alternativas que ofrece HEC-HMS se utilizará la calibración basada en 

el número de curva. 

 

Paso 1. Creación de un nuevo modelo de cuenca 

El nuevo modelo coincide prácticamente con la subcuenca del río Cofio. Por tanto, vamos a 

aprovechar el modelo anterior, eliminando el resto de subcuencas y modificando la superficie. 

Sobre el modelo de cuenca Alberche, pinchamos con el botón derecho y seleccionando Create 

Copy... 

 
Damos nombre al nuevo modelo y lo describimos brevemente. 
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Eliminamos todas las subcuencas (excepto la denominada como Cofio), todos los tramos y 

todas las confluencias, y definimos el elemento Salida (Sink) en el cierre de la cuenca.  

Según la información que proporciona el SAIH, el área de la cuenca donde se encuentra la 

estación de aforos es de 627,81 km2. 

En la subcuenca Cofio, dejamos todo igual excepto la superficie (627,81 km2) y el nudo de 

aguas abajo, que ahora es la Salida. 

 

Paso 2. Creación del hietograma registrado 
Components → Time-Series Data Manager  
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En Data Type seleccionamos Precipitation Gages. Y pinchando en New damos nombre al 

hietograma registrado. 

 

En la pestaña Time-Series Gage se define: 

 Description: es la descripción que se ha dado al generar el hietograma. 

 Data Source: seleccionamos Manual Entry. 

 Units: seleccionamos las unidades de medida (Incremental Milimeters). 

 Time Interval: seleccionamos el intervalo del hietograma (1 Hour). 

 Latitude Degrees, Latitude Minutes, Latitude Seconds, Longitude Degrees, Longitude Minutes, Longitude 

Seconds: lo dejamos en blanco. 
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En la pestaña Time Window se define: 

 Start Date (ddMMMYYYY): es la fecha de comienzo de la precipitación. Ponemos como fecha 

el 20 de abril de 2011. 

 Start Time (HH:mm): es la hora de comienzo de la precipitación. Dejamos la fecha que viene 

por defecto (00:00). 

 End Date (ddMMMYYYY): es la fecha de finalización de la precipitación. Ponemos como fecha 

el 24 de abril de 2011. 

 End Time (HH:mm): es la hora de finalización de la precipitación. Ponemos las 23:00. 
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En la pestaña Table introducimos los valores de precipitaciones registrados, que se encuentran 

en el archivo Datos_calibración.xlsx. 

 

 

En la pestaña Graph se puede observar gráficamente el hietograma. 
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Paso 3. Creación de un nuevo modelo meteorológico 

Components → Meteorologic Model Manager 

 

Pinchando en New damos nombre al modelo. 
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Paso 4. Asociación del hietograma a la cuenca 

Pinchando sobre el modelo meteorológico generado (Cofio - Calibración), en la pestaña 

Meteorology Model definimos: 

 Description: es la descripción que se ha dado al generar el modelo meteorológico. 

 Shortwave: --None--. 

 Longwave: --None--. 

 Precipitation: seleccionamos Specified Hyetograph. 

 Evapotranspiration: --None--. 

 Snowmelt: --None--. 

 Unit System: seleccionamos el sistema de medida (Metric). 

 Replace Missing: seleccionamos Abort Compute. 
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En la pestaña Basins seleccionamos Yes, dentro de Include Subbasins, en el modelo Cofio. 

 
 

En la pestaña Options seleccionamos No, dentro de Total Override. 

 

Para asignar el hietograma a la cuenca pinchamos sobre Specified Hyetograph y realizamos la 

asignación. 
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Paso 5. Creación del hidrograma registrado 
Components → Time-Series Data Manager 
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En Data Type seleccionamos Discharge Gages. Y pinchando en New damos nombre al 

hidrograma registrado. 

 

En la pestaña Time-Series Gage se define: 

 Description: es la descripción que se ha dado al generar el hidrograma. 

 Data Source: seleccionamos Manual Entry. 

 Units: seleccionamos las unidades de medida (Cubic Meters Per Second). 

 Time Interval: seleccionamos el intervalo del hidrograma (1 Hour). 
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En la pestaña Time Window se define: 

 Start Date (ddMMMYYYY): es la fecha de comienzo de las medidas de caudal registrado. 

Ponemos como fecha el 20 de abril de 2011. 

 Start Time (HH:mm): es la hora de comienzo de las medidas de caudal. Dejamos la fecha que 

viene por defecto (00:00). 

 End Date (ddMMMYYYY): es la fecha de finalización de las medidas de caudal registrado. 

Ponemos como fecha el 24 de abril de 2011. 

 End Time (HH:mm): es la hora de finalización de las medidas de caudal. Ponemos las 23:00. 
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En la pestaña Table introducimos los valores de caudal registrado, que se encuentran en el 

archivo Datos_calibración.xlsx. 

 

 

En la pestaña Graph se puede observar gráficamente el hidrograma registrado. 
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Paso 6. Asignación del hidrograma al punto de cierre 

Pinchando sobre el elemento Salida del modelo de cuenca Cofio, en la pestaña Options 

asociamos el hidrograma registrado (Cofio - Calibración) en Observed Flow. 

 

Paso 7. Creación de la calibración 
Compute → Create Compute → Optimization Trial... 
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Damos nombre a la simulación (Optim-Alberche). 

 
 

Seleccionamos el modelo de cuenca (Cofio). 
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Seleccionamos el punto donde se ha registrado el caudal (Salida). 

 
 

Seleccionamos el modelo meteorológico (Cofio-Calibración). 
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Paso 8. Definición de las opciones de calibración 

Pinchamos sobre la pestaña Compute para acceder al menú de Calibración. 

 

 

En la pestaña Optimization Trial se define: 

 Description: es la descripción de la calibración. 

 DSS File: dejamos la ruta que viene por defecto. 

 Basin Model: seleccionamos el modelo de cuencas (Cofio). 

 Meteorologic Model: seleccionamos el modelo meteorológico (Cofio-Calibración). 

 Start Date (ddMMMYYYY): es la fecha de comienzo de la calibración. Ponemos como fecha el 

20 de abril de 2011. 

 Start Time (HH:mm): es la hora de comienzo de la calibración. Dejamos la fecha que viene por 

defecto (00:00). 

 End Date (ddMMMYYYY): es la fecha de finalización de la calibración. Ponemos como fecha 

el 24 de abril de 2011. 

 End Time (HH:mm): es la hora de finalización de la calibración. Ponemos las 23:00. 

 Time Interval: seleccionamos 1 Hour. 

 Method: seleccionamos Univariate Gradient. 

 Tolerance: dejamos el valor que viene por defecto (0.01). 

 Max Iterations: dejamos el valor que viene por defecto (50). 
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En la pestaña Objetive Function se define: 

 Method: seleccionamos Percent Error Peak. 

 Location: seleccionamos Salida. 

 Missing Flow (%): ponemos 0. 

 Start Date (ddMMMYYYY): es la fecha de comienzo de la calibración. Ponemos como fecha 

el 20 de abril de 2011. 

 Start Time (HH:mm): es la hora de comienzo de la calibración. Dejamos la fecha que viene 

por defecto (00:00). 

 End Date (ddMMMYYYY): es la fecha de finalización de la calibración. Ponemos como 

fecha el 24 de abril de 2011. 

 End Time (HH:mm): es la hora de finalización de la calibración. Ponemos las 23:00. 
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Paso 9. Definición del parámetro a optimizar 

Compute → Trial Add Parameter 

 

 

En este caso vamos a realizar la calibración según el número de curva. 

En la pestaña Parameter 1 se define: 

 Element: seleccionamos Cofio. 
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 Parameter: seleccionamos SCS Curve Number - Curve Number. 

 Initial Value (): dejamos el valor inicial del número de curva (58.62). 

 Locked: seleccionamos No. 

 Minimum: dejamos el valor que viene por defecto. 

 Maximum: dejamos el valor que viene por defecto. 

 
 

Paso 10. Selección de la calibración 
En el desplegable indicado a continuación se selecciona la calibración generada. 
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Paso 11. Calibración 

Pinchamos sobre . 

 
 

Paso 12. Consulta de los resultados 
En la pestaña Results se pueden observar los resultados de la calibración de diferentes maneras. 
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La tabla Optimized Parameters nos da el valor inicial del número de curva y el optimizado. 

 

En este caso, la calibración nos dice que deberíamos reducir ligeramente el número de curva 

para conseguir un ajuste óptimo. Pero debido a la escasa diferencia entre el número de curva 

estimado y el calculado, se ha decidido no modificar el valor. 

 

También se pueden observar los resultados de la calibración en términos de caudal, ya sea 

numéricamente, en la tabla Objetive Function Summary. 
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O en forma de hidrograma, en el gráfico Hydrograph Comparison. 

 
 

9. Simulación 

Como hemos decidido no modificar el número de curva inicialmente estimado, no es 

necesario realizar ninguna modificación en el modelo de cuencas. Si se decidiese modificar este 

valor, habría que ir cambiándolo en cada una de las subcuencas. 

Paso 1. Creación de la simulación 

Compute → Create Compute → Simulation Run... 
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Damos nombre a la simulación (Alberche T=10). 

 
 

Seleccionamos el modelo de cuenca (Alberche). 
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Seleccionamos el modelo meteorológico (Alberche). 

 
 

Seleccionamos las especificaciones de control (Alberche). 
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Paso 2. Selección de la simulación 

En el desplegable indicado a continuación se selecciona la simulación generada. 

 
 

Paso 3. Simulación 

Pinchamos sobre . 
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Paso 4. Consulta de los resultados 

Pinchando en el mapa sobre cada uno de los elementos, ya sean subcuencas, tramos, 

confluencias o salida, podemos observar los resultados obtenidos. El programa permite consultar 

los resultados en forma de hidrograma o numéricamente. En este caso, como queremos calcular 

el caudal en el cierre de la cuenca, pinchamos sobre el elemento Salida. 

Para ver los resultados en forma de hidrograma pinchamos sobre  

 
 

Y para ver los resultados en forma numérica pinchamos en  
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10. Reflexiones finales 

Los modelos hidrológicos son herramientas muy útiles para predecir el comportamiento de las 

cuencas frente a las precipitaciones, pero no debemos olvidarnos que no son más que 

aproximaciones basadas simulaciones, estadísticas y suposiciones y que, por tanto, los resultados 

obtenidos en el modelo no coincidirán perfectamente con los caudales registrados para una 

misma tormenta. Como es lógico, cuanto más se afine en el método para obtener los diferentes 

parámetros hidrológicos, más preciso será el modelo. Así, por ejemplo, cuanto mayor sea la 

discretización del terreno para obtener el número de curva, más próximo se estará del valor real. 

En este sentido, la elección de una escala de trabajo adecuada es fundamental para obtener unos 

resultados aceptables. 

Del mismo modo, para obtener unos buenos resultados, es necesario utilizar una información 

de partida lo más actual posible y con la suficiente calidad y resolución para que refleje la 

situación real de la cuenca. El empleo de mapas de usos del suelo antiguos puede originar 

resultados muy diferentes a los esperados debido a los cambios que el hombre haya podido 

introducir en el terreno.  

Por otro lado, para dar por bueno el modelo es imprescindible realizar la calibración del 

mismo, ya sea de la cuenca completa o de una parte de la misma. Con la calibración se realizan 

los ajustes necesarios para adaptar los resultados obtenidos a los registrados. Además, es 

importante la selección de la tormenta adecuada, ya que, en ciertos casos, pueden darse errores en 

el registro de los datos que hacen que la calibración no sea posible. Por tanto, debe realizarse un 

tanteo entre las diferentes tormentas registradas disponibles y seleccionar la que mejor se ajuste al 

modelo. 

Otro aspecto importante a tener en cuenta a la hora de elaborar los modelos hidrológicos son 

las actuaciones antrópicas, como embalses, derivaciones, aportes, etc., que deben quedar 

perfectamente definidas, lo que puede suponer una complejidad excesiva debido a las múltiples 

maniobras de regulación que se pueden llevar a cabo. En sentido contrario se encuentran los 

modelos en régimen natural, como el del ejercicio práctico. Dentro de estos modelos destacan los 

que tienen por finalidad la definición del dominio público hidráulico, que deben despreciar 

cualquier infraestructura existente en el cauce. 

El ejemplo que se ha utilizado para realizar el autoaprendizaje se ajusta a los requerimientos de 

datos y las necesidades de trabajo del modelo hidrológico HEC-HMS sobre las características de 

una cuenca real para que sea fiable en su aplicación, siguiendo todos los pasos y protocolos 

requeridos en su secuencia de modelado. Eso nos pone ante un aspecto crucial de los modelos 

hidrológicos, que es su elección. Se puede decir que no hay modelos buenos, malos, o mejores. 

Sobre todo se trata de saber de antemano para qué queremos aplicar la modelización, las 

propiedades reales de la cuenca en la que se va a desarrollar la modelización, los datos con los que 

se cuenta, la pericia y conocimiento hidrológico de las personas que van a estar involucradas en el 

proceso y las características del modelo (o modelos). Si se tiene en cuenta todos esos factores, se 
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garantiza la optimización de la aplicación de un modelo hidrológico, su eficacia suficiente, y, 

sobre todo, la mejor comprensión de los resultados obtenidos. 
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